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Einführung

Im Kapitel 6 “Einführung in Vorlagen“ wird die Anwendung und die Verwaltung von Formatvorlagen
beschrieben. In diesem Kapitel wird erklärt, wie Formatvorlagen erstellt und geändert werden und 
welche Einstellmöglichkeiten Ihnen in den Dialogfenstern dabei zur Verfügung stehen. Sie werden 
lernen, wie die Einstellungen das Aussehen des Textes beeinflussen und wie Sie diese am besten 
für Ihre Dokumente einsetzen. Beispiele und Hinweise verdeutlichen die Auswirkungen der durch-
geführten Änderungen.

Die Seiten im Dialogfensters zum Formatieren der Formatvorlagen gleichen denen für die manuel-
le Formatierung eines Textes, so dass Sie dieses Kapitel auch als Anleitung und Beispiel dafür nut-
zen können.

Neue Formatvorlagen erstellen

Neben den in LibreOffice vordefinierten Formatvorlagen können Sie eigene (benutzerdefinierte) 
Formatvorlagen erstellen und verwenden. Sie erstellen neue Vorlagen entweder per Drag & Drop 
oder über die Schaltfläche Neue Vorlage aus Selektion        ganz rechts im oberen Teil des Fens-
ters Formatvorlagen (über die Funktionstaste F11, das Menü Format > Formatvorlagen oder das 
Symbol  oder        in der Symbolleiste Format zu erreichen).

Per Drag & Drop wird beispielsweise ein Absatz fertig formatiert, in die Absatzvorlage gezogen 
und anschließend ein Name zugeordnet.

Bei der Erstellung über das Dialogfenster Formatvorlagen erfolgen die Einstellungen zentral über 
ein Dialogfenster und nicht über mehrere, verteilte Menüpunkte. Viele Änderungen lassen sich be-
reits vor der Erstellung der eigentlichen Vorlage in einem Vorschaufenster erkennen.

Beide Methoden empfehlen sich, um die Auswirkungen durch Formatierungsänderungen bereits 
vor der Erstellung neuer Formatvorlage zu erfassen und zu kontrollieren.

In diesem Kapitel werden nur die Einstellungen über das Dialogfenster Formatvorlagen beschrie-
ben, da hier die Einstellungen zentral über ein Dialogfenster erfolgen kann.

Das Dialogfenster Formatvorlagen
Öffnen Sie das Dialogfenster Formatvorlagen. Wählen Sie die Art der Formatvorlage über die 
Symbolleiste am oberen Rand (Abbildung 1).

Ein Rechtsklick in den darunter liegenden Bereich der Formatvorlagen öffnet ein Kontextmenü, aus
dem Sie Neu auswählen. Während für die Absatz- und Zeichenvorlagen immer eine der vorhande-
nen Vorlagen als Grundlage für die neue Vorlage dient, ist das bei den Rahmen-, Seiten- und Lis-
tenvorlagen nicht der Fall. Das erkennen Sie im Dialogfenster für die neue, noch unbenannte Vor-
lage: Im Feld Verknüpft mit bzw. Beerben für die Absatz- und Zeichenvorlage ist die Ausgangs-
vorlage eingetragen. Sie können an dieser Stelle auch eine andere Ausgangsvorlage oder Keine 
wählen. Für die Seiten- und Listenvorlagen steht der Eintrag Keine nicht zur Verfügung.

Je nach ausgewählter Vorlagenart öffnen sich unterschiedliche Dialogfenster. Sie sind größtenteils 
identisch mit denen, die Sie aus der manuellen Formatierung kennen. Wenn Sie also Erfahrungen 
mit der manuellen Formatierung von LibreOffice haben, werden Sie die meisten Optionen und Ein-
stellmöglichkeiten bereits kennen.

Tipp
Die Dialogfenster für eine neue und für die Änderung bestehender Vorlagen sind 
oftmals dieselben. Bedingte Vorlagen dagegen weichen davon ab. Weitere Infor-
mationen finden Sie unter Arbeiten mit bedingten Absatzvorlagen auf Seite 27.
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Abbildung 1: Die Formatvorlagen von Writer.

Die Seite Verwalten
Wenn Sie eine neue Vorlage erstellen, sollten Sie als Erstes über die Seite Verwalten der neuen 
Vorlage einen aussagekräftigen Namen geben (Abbildung 2). Diese Seite ist für alle Vorlagenarten 
vorhanden, kann aber zwischen den Vorlagenarten etwas variieren.

Abbildung 2: Die Absatzvorlage, Seite Verwalten.

Abhängig von der Formatvorlage können Sie auf dieser Seite allgemeine Angaben machen:

• Name: Für alle Formatvorlagen. Zeigt den Namen der Formatvorlage an. Vergeben Sie ei-
nen Namen für eine neue Formatvorlage.

• Automatisch aktualisieren (Standard: Nicht aktiviert): Nur für Absatz- und Rahmenvorla-
gen. Bei aktivierter Option werden Änderungen durch direkte Formatierung (z. B. über das 
Menü: Format > Absatz) in die entsprechende Formatvorlage geschrieben und alle übri-
gen Absätze im Dokument, die ebenfalls auf dieser Formatvorlage beruhen, werden auto-
matisch angepasst.
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Achtung Wenn Sie gewöhnlich die direkte (manuelle) Formatierung verwenden, vergewis-
sern Sie sich, dass die Option Automatisch aktualisieren nicht aktiviert ist. An-
dernfalls können Teile des Dokuments unerwartet neu formatiert sein.

• Folgevorlage Standard: Name der Formatvorlage): nur für Absatz- und Seitenvorlagen. 
Damit legen Sie die Formatvorlage für den nachfolgenden Absatz oder die nachfolgende 
Seite fest. So können Sie beispielsweise einer linken Seite eine rechte folgen lassen. Ein 
Beispiel weiter unten verdeutlicht die Verwendung (s.a. Seite Fehler: Referenz nicht gefun-
den). Die Eigenschaft Folgevorlagen wird häufig für vordefinierte Absatzvorlagen für Lis-
ten oder Aufzählungen verwendet.

• Verknüpft mit: Nur für Absatz-, Zeichen und Rahmenvorlagen. Beim Erstellen einer neuen 
Formatvorlage wird:

◦ Die neue Formatvorlage wird mit der Formatvorlage verknüpft, die Sie über Rechts-
klick ausgewählt haben, um diese neue Formatvorlage zu erstellen.

◦ Der Name der über Rechtsklick ausgewählten Formatvorlage wird in das Feld Ver-
knüpft mit eingetragen.

◦ Die Eigenschaften der über Rechtsklick ausgewählten Formatvorlage wird in die neue
Formatvorlage übernommen.

• Bereich: Für alle Formatvorlagen. Hier legen Sie fest, in welchem Bereich die Formatvor-
lage sichtbar ist. Den Bereich können Sie unterhalb der Formatvorlage filtern.

Achtung Beachten Sie, dass Sie für die von LibreOffice vordefinierte Formatvorlagen den 
Bereich nicht ändern können. Die Verwendung des Filters bietet sich an, wenn Sie 
bestimmten Formatvorlagen anzeigen lassen wollen - z.B. alle verwendeten oder 
die miteinander verknüpften Formatvorlagen (hierarchisch).

• Enthält: Zeigt eine Zusammenfassung der Eigenschaften der Formatvorlage.

Verknüpfte Vorlagen
Neue Zeichen- oder Absatzvorlagen erstellen Sie, indem Sie eine
vorhandene Vorlage als Ausgangsvorlage verwenden. LibreOffice
verknüpft die beiden Vorlage miteinander.

Änderungen an der Ausgangsvorlage führen dazu, dass bei den
übernommenen Eigenschaften auch die neu erstellte Vorlage geän-
dert wird. Sie können die Abhängigkeiten in der hierarchischen An-
sicht des Formatvorlagenfensters sehen. So ist jede Überschriften-
vorlage, wie Überschrift 1, Überschrift 2 usw. mit der Formatvorlage 
Überschriften verbunden (Abbildung 3).

Mit verknüpften Vorlagen lassen sich ganze „Familien“ von Vorlagen
erstellen und deren Eigenschaften gleichzeitig ändern.

Ein Beispiel: Wenn die Überschriften - wie in diesem Handbuch -
grün erscheinen sollen, brauchen Sie nur die Schriftfarbe der übergeordneten Vorlage ändern, um 
auch die Schriftfarbe der abgeleiteten Formatvorlagen zu ändern.

Beachten Sie bitte, dass Änderungen, die Sie bereits an untergeordneten Formatvorlagen vorge-
nommen haben, nicht von Änderungen der übergeordneten Formatvorlagen betroffen sind. Haben 
Sie also im obigen Beispiel der Überschrift 2 bereits eine andere Schriftfarbe zugeordnet, so wird 
diese bei Änderungen der Schriftfarbe in der Formatvorlage Überschriften nicht geändert. Im Be-
reich Enthält auf der Seite Verwalten können Sie sehen, welche Eigenschaften gegenüber der 
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übergeordneten Formatvorlage geändert wurden. Bei den Zeichen- und Absatzvorlagen können 
Sie über die Schaltfläche Standard die geänderten Werte auf die Werte der übergeordneten For-
matvorlage zurück setzen.

Notiz
Für Seiten-, Rahmen- und Listenvorlagen können Sie keine hierarchischen Vorla-
genstrukturen definieren.

Verknüpfte Formatvorlagen erstellen
Eine verknüpfte Formatvorlage lässt sich auf zweierlei Weise erstellen:

• Die Ausgangsvorlage wird in das Feld Verknüpft mit auf der Seite Verwalten im Dialog-
fenster Formatvorlagen eingetragen oder

• durch Rechtsklick auf eine vorhandene Formatvorlage und Auswahl des Menüpunktes Neu
aus dem sich öffnenden Kontextmenü.

Beispiel: Änderung der übergeordneten Formatvorlage
Um beispielsweise die Schriftart aller Überschriften, nicht nur die Schrift der Formatvorlage Über-
schrift 1 oder Überschrift 2 zu ändern, nutzen Sie die Vorteile der verknüpften Formatvorlagen.

Öffnen Sie das Dialogfenster Formatvorlagen (über die Sondertaste F11 oder das Menü Format 
> Formatvorlagen) und wählen Sie mit einem Rechtsklick auf die Formatvorlage Überschrift aus 
dem Kontextmenü den Eintrag Ändern.

Im geöffneten Dialogfenster für die Absatzvorlage Überschrift selektieren Sie die Seite Schrift 
und ändern dort die Schriftart und gegebenenfalls den Schriftschnitt (Stil) und die Schriftgröße (Ab-
bildung 4). Über die Schaltfläche OK übernehmen Sie die Änderungen und verlassen das Dialog-
fenster wieder.

Abbildung 4: Die Absatzvorlage LibOÜberschrift, Seite Schrift.

Damit werden in einem Schritt die Schriftart in allen verknüpften Überschriften-Formatvorlagen 
(Überschrift 1 bis Überschrift 10) geändert. Abbildung 5 zeigt links die Überschriften 1 bis Über-
schrift 4 und rechts dasselbe Dokument mit einer in der Formatvorlage Überschrift geänderten 
Schriftart.
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Abbildung 5: Änderung der Schriftart der übergeordneten Absatzvor-
lage „Überschrift“: Links Arial, rechts Times New Roman.

Absatzvorlagen

In diesem Abschnitt werden die Parameter der Absatzvorlage beschrieben. In den meisten Fällen 
ist es ausreichend, einige Werte zu ändern - insbesondere wenn Sie abgeleitete Formatvorlagen 
verwenden oder eine neue Formatvorlage auf Basis einer vorhandenen erstellen wollen. Die Werte
brauchen also nicht jedes mal neu eingegeben werden.

Einzüge und Abstände
Auf der Seite Einzüge und Abstände (Abbildung 6) legen Sie die Werte für den Einzug, den Ab-
stand zwischen den Absätze und den Zeilenabstand fest. Im rechten Teil wird eine Vorschau zu 
den Änderungen angezeigt. Über die Schaltfläche Zuweisen werden die eingestellten Werte auf 
den aktuellen Absatz anwendet.

Für einen Absatz können Sie im Bereich Einzug die folgenden Parameter einstellen:

• Vor Text (Standard: 0,00 cm): Abstand vom linken Seitenrand zum Text bzw. zu Nummerie-
rungs- oder Aufzählungszeichen. Negative Werte lassen den Absatz vor dem eingestellten 
linken Rand beginnen. Das kann hilfreich sein, wenn bei sehr breiten linken Rändern eine 
Überschrift nur auf einer Zeile erscheinen soll. Bei von links nach rechts verlaufenden 
Sprachen (wie z.B. bei der deutschen Sprache) wird der linke Rand des Absatzes vom lin-
ken Seitenrand aus eingerückt. Bei von rechts nach links verlaufenden Sprachen (wie z.B. 
bei der arabischen Sprache) wird der rechte Rand des Absatzes vom rechten Seitenrand 
aus eingerückt.

• Hinter Text (Standard: 0,00 cm): Abstand vom rechten Seitenrand zum Text. Negative 
Werte lassen den Text über den eingestellten rechten Rand fließen. Bei von links nach 
rechts verlaufenden Sprachen wird der rechte Rand des Absatzes vom rechten Seitenrand 
aus eingerückt. Bei von rechts nach links verlaufenden Sprachen wird der linke Rand des 
Absatzes vom linken Seitenrand aus eingerückt.

• Erste Zeile (Standard: 0,00 cm): Rückt die erste Zeile eines Absatzes zusätzlich um den 
angegebenen Wert gegenüber dem Wert im Feld Vor Text ein. Ein negativer Wert erzeugt 
einen hängenden Einzug, d. h. die erste Zeile beginnt vor den anderen Zeilen des Absat-
zes. Um die erste Zeile eines nummerierten oder mit Aufzählungszeichen versehenen Ab-
satzes einzurücken, wählen Sie im Menü Format > Nummerierung und Aufzählungszei-
chen und dort die Seite Position (siehe auch Listenvorlagen, Seite Position, S. 53).

• Automatisch (Standard: Nicht aktiviert): Rückt den Absatz automatisch im Verhältnis zur 
Schriftgröße und zum Zeilenabstand ein. Die Einstellung im Feld Erste Zeile wird dann 
ignoriert.
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Abbildung 6: Die Absatzvorlage, Seite Einzüge und Abstände.

Im Bereich Abstand auf der Seite Einzüge und Abstände lassen sich die Abstände über und unter
einem Absatz festlegen. Üblicherweise wird bei Überschriften ein Abstand zum vorhergehenden 
Text eingehalten. Auch zwischen einzelnen Absätzen werden mitunter andere Abstände eingestellt,
z. B. bei Aufzählungen und Nummerierungen. Diese Abstände sollten Sie ohne leere Absätze 
(durch Drücken der RETURN-Taste) erzeugen. Die in diesem Dokument verwendeten Formatvor-
lagen sind so konfiguriert, dass zwischen den einzelnen Absätzen etwas Platz gelassen wird.

• Über Absatz (Standard: 0,00 cm): Abstand zum vorhergehenden Absatz.

• Unter Absatz (Standard: 0,00 cm): Abstand zum nachfolgenden Absatz.

• Keine Abstände zwischen Absätzen derselben Vorlage (Standard: Nicht aktiviert): Zwi-
schen den Absätzen der gleichen Formatvorlage werden Abstandsangaben ignoriert und 
kein Abstand eingefügt.

Der Bereich Zeilenabstand legt den Abstand der Zeilen innerhalb eines Absatzes fest. Über eine 
Auswahlliste stehen die Werte zur Verfügung:

• Einfach (Standard): Im ausgewählten Absatz wird ein einzeiliger Abstand eingestellt. Der 
Abstand selber wird anhand der Schriftgröße berechnet. Der einzeilige Zeilenabstand ist 
die Standardeinstellung.

• 1,5-zeilig: Stellt im Absatz einen 1,5-zeiligen Abstand ein.

• Doppelt: Stellt im Absatz einen zweizeiligen Abstand ein.

• Proportional: Stellt im Absatz einen in Prozent anzugebenden Abstand ein. Im Feld von 
ist der entsprechende Wert einzugeben. Der Wert 100 % entspricht einem einzeiligen und 
200 % einem zweizeiligen (doppelten) Abstand.

• Mindestens: Setzt einen Mindestabstand zwischen den Zeilen eines Absatzes.

• Durchschuss: Fügt zwischen zwei Zeilen einen zusätzlichen, im Feld von einzutragenden 
Wert als Höhenabstand ein.
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• Fest: Setzt einen festen Zeilenabstand zwischen den Zeilen eines Absatzes. Der Abstand 
ist im Feld von einzutragen. Bei einem zu geringem Abstand werden die Buchstaben oben 
von der darüber liegenden Zeile abgeschnitten.

Tipp

Wenn Sie innerhalb eines Absatzes unterschiedliche Schriftgrößen verwenden, 
passt LibreOffice den Zeilenabstand automatisch an die größte verwendete 
Schriftgröße an. Falls Sie lieber einen für alle Zeilen gleichen Abstand für die Zei-
lenabstände Mindestens oder Fest wünschen, können Sie im Feld von einen 
Wert angeben, der auch für die größte verwendete Schrift hoch genug ist.

Im Bereich Registerhaltigkeit können Sie die Option Berücksichtigen aktivieren (Standard: Nicht 
aktiviert).

Registerhaltigkeit ist ein typografischer Ausdruck besonders für das Drucken von Büchern, Zeitun-
gen und Zeitschriften. Damit werden die Zeilen auf der Vorder- und Rückseite einer Seite oder ei-
nes Buchumschlages so ausgerichtet, dass Zeilen auf beiden Seiten exakt auf derselben Höhe lie-
gen. Kontrolliert wird das Register beim Drucken, indem die Seite gegen das Licht gehalten wird 
und somit der Stand des Elementes (Zeilen, Zeilenhöhe, Ränder usw.) durch das Papier hindurch 
betrachtet werden kann. Ist ein Text registerhaltig, so liegen z. B. die Zeilen einer Buchseite exakt 
übereinander.

Diese Funktion lässt sich nur einsetzen, wenn die Option Registerhaltigkeit für die aktuelle Sei-
tenvorlage aktiviert ist. Hierzu wählen Sie Format > Seite..., klicken auf das Register Seite und ak-
tivieren die Option Registerhaltigkeit im Bereich Layouteinstellungen.

Ausrichtung
Über die Seite Ausrichtung lässt sich die Ausrichtung des Absatzes in Bezug auf die Seitenränder
festlegen (Abbildung 7).

Abbildung 7: Die Absatzvorlage, Seite Ausrichtung.

Die einzelnen Felder im Bereich Optionen haben dabei die Bedeutung:

• Links (Standard): Der Absatz wird linksbündig ausgerichtet.

• Rechts: Der Absatz wird rechtsbündig ausgerichtet.

• Zentriert: Der Absatz wird zentriert ausgerichtet.

• Blocksatz: Richtet den Absatz als Blocksatz aus, d. h. der Text wird am linken und am 
rechten Rand bündig ausgerichtet. Für diese Option sind weitere Einstellungen möglich:
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◦ Letzte Zeile: Diese Option ist nur für die Ausrichtungsart Blocksatz verfügbar. Die 
Ausrichtung der letzten Zeile des Blocksatzes kann verschieden sein:

◊ Links: Die letzte Zeile wird linksbündig ausgerichtet. Das ist normalerweise die 
Standardeinstellung.

◊ Zentriert: Die letzte Zeile wird zentriert ausgerichtet.

◊ Blocksatz: Auch der letzte Satz wird als Blocksatz formatiert. Dabei wird der Ab-
stand zwischen den Worten so eingestellt, dass die Worte über die ganze Ab-
satzbreite ausgedehnt wird. Bei nur wenigen Worten in der letzten Zeile, kann 
der Abstand sehr groß werden (Abbildung 8).

Abbildung 8: Die letzte Zeile wird ebenfalls als Blocksatz ausgerich-
tet, die Worte werden über die gesamte Absatzbreite ausgedehnt.

◦ Einzelnes Wort austreiben: Besteht die letzte Zeile des Absatzes aus einem einzel-
nen Wort, so wird dieses Wort über die gesamte Absatzbreite ausgedehnt. Der Ab-
stand zwischen den einzelnen Buchstaben des Wortes können dabei sehr groß wer-
den (Abbildung 9).

◦ Am Textraster fangen: Der Absatz wird an einem Textraster ausgerichtet. Diese Opti-
on ist nur verfügbar, wenn die Asiatische Sprachunterstützung aktiviert ist (über das 
Menü Extras > Optionen > Spracheinstellungen > Sprachen im Bereich Standard-
sprachen der Dokumente die Option Asiatisch). Das Textraster aktivieren Sie über 
das Menü Format > Seite, Reiter Textraster.

Auf der Seite Ausrichtung stellen Sie im Bereich Text-an-Text die senkrechte Ausrichtung des 
Textes ein, wenn im Satz Zeichen mit Über- oder Untergrößen auftreten. Setzen Sie den Cursor in 
den zu formatierenden Absatz oder markieren Sie mehrere Absätze und wählen die Ausrichtung 
aus dem Aufklappmenü:

• Automatisch (Standardeinstellung): Writer richtet den Text automatisch aus.

• Grundlinie: Die kleineren Zeichen eines Textes werden an der Grundlinie der großen Zei-
chen ausgerichtet.

• Oben: Die kleineren Zeichen eines Textes werden an der oberen Linie der großen Zeichen 
ausgerichtet.

• Mitte: Die kleineren Zeichen eines Textes werden mittig an den großen Zeichen ausgerich-
tet.

• Unten: Die kleineren Zeichen eines Textes werden an der unteren Linie der großen Zei-
chen ausgerichtet.

Abbildung 10 zeigt Beispiele für die vertikale Ausrichtung.
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Abbildung 10: Text-an-Text-Ausrichtung auf der Seite 
Ausrichtung der Formatvorlage für Absätze.

Textfluss
Auf dieser Seite kontrollieren Sie den Textfluss, wie Silbentrennung und Umbrüche (Abbildung 11). 
Im Bereich Optionen sind weitere typografische Einstellungen möglich.

Abbildung 11: Die Absatzvorlage, Seite Textfluss.

Der Bereich Silbentrennung legen Sie die Einstellungen für die Silbentrennung fest:

• Automatisch (Standard: Nicht aktiviert): Diese Option schaltet die automatische Silben-
trennung für den ganzen Absatz ein oder aus und fügt die notwendigen Trennstriche ein. 
Die Silbentrennung erfolgt dann während der Eingabe.

• Zeichen am Zeilenende (Standard: 2 Zeichen): Hiermit legen Sie die minimale Anzahl an 
Zeichen fest, die mindestens am Ende der Zeile verbleiben müssen, bevor ein Trennstrich 
eingefügt wird.

• Zeichen am Zeilenanfang (Standard: 2 Zeichen): Minimale Anzahl an Zeichen, die min-
destens am Anfang der neuen Zeile stehen müssen, nachdem ein Trennstrich eingefügt 
wurde.
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• Maximal aufeinander folgende Trennstellen (Standard: 0): Geben Sie an, in wie vielen 
aufeinander folgenden Zeilen maximal eine Trennung stattfinden darf. Null bedeutet in je-
der Zeile.

Tipp

Wenn Sie mit dem Ergebnis der Silbentrennung nicht einverstanden sind, können 
Sie über das Menü Extra > Sprache > Silbentrennung die Silbentrennung noch 
einmal anstoßen oder selbst bedingte Trennstriche über die Tastenkombination 
Strg+(Minus) (-) eingeben.

Im Bereich Umbrüche legen Sie die Bedingungen für die Seiten- und Spaltenumbrüche fest. Dazu 
gehören die Art und Position des Umbruchs, die Formatvorlage der neuen Seite und die Seiten-
nummer, mit der die neue Seite beginnt, wenn z. B. auf der neuen Seite ein neues Kapitel beginnt.

Im Einzelnen habe die Felder die Bedeutung:

• Einfügen (Standard: Nicht aktiviert): Aktivieren Sie dieses Feld, um einen Seiten- oder 
Spaltenumbruch einzufügen. Erst wenn dieses Auswahlfeld markiert ist, werden die ande-
ren Felder verfügbar:

◦ Seite: Seitenumbruch

◦ Spalte: Spaltenumbruch

• Typ: Über eine Auswahlliste können Sie einen Seiten- oder Spaltenumbruch auswählen. 
den Sie einfügen möchten.

• Position: Geben Sie an, an welcher Position der Umbruch eingefügt werden soll: 

◦ Vor: Vor der aktuellen Cursorposition.

◦ Hinter: Hinter der aktuellen Cursorposition.

• mit Seitenvorlage: Aktivieren Sie dieses Feld und wählen Sie aus der Auswahlliste die ge-
wünschte Seitenvorlage für die erste Seite nach dem Umbruch aus. Die aufgeführten Sei-
tenvorlagen entsprechen den Vorlagen im Formatvorlagenfenster (das erreichen Sie über 
die Tastenkombination F11 oder über das Menü Format > Formatvorlagen.

• Seitennummer (Standard: 0): Geben Sie die Seitenzahl ein, die auf der ersten Seite nach 
dem Umbruch erscheinen soll. Für die Fortsetzung der aktuellen Seitennummerierung ge-
ben Sie "0" ein.

Notiz
Umbrüche lassen sich auch über das Menü Einfügen > Manueller Umbruch ... 
einfügen.

Notiz

Soll die erste Seite eines neuen Kapitels mit einer rechten Seite anfangen, müs-
sen Sie, falls nicht vorhanden, zuerst eine Seitenformatvorlage für eine rechte Sei-
te im Formatvorlagenfenster erstellen (Menü Format > Formatvorlagen oder 
Sondertaste F11). Anschließend können sie diese dann im Feld mit Seitenvorlage
auswählen.

Der Bereich Optionen bietet Ihnen Einstellmöglichkeiten für die Absätze vor und hinter dem Text-
umbruch:

• Absatz nicht trennen: Der Absatz wird bei einem Umbruch nicht getrennt. Passt der Ab-
satz nicht auf die Seite, so wird der Absatz komplett an den Anfang der nächsten Seite ver-
schoben.

• Mit folgendem Absatz zusammen halten: Hiermit legen Sie fest, dass der aktuelle Absatz
mit dem folgenden Absatz auf derselben Seite steht. Das ist z. B. bei Überschriften oder 
Einführungssätzen zu Auflistungen sehr nützlich.
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• Schusterjungenregelung (Standard: 2): Die Schusterjungenregelung ist eine typografi-
sche Regel, die festlegt, wie viele Zeilen eines Absatzes mindestens vor einem Seiten- 
oder einem Spaltenumbruch stehen bleiben müssen. Aktivieren Sie dieses Markierfeld und 
geben Sie die gewünschte Anzahl in das Feld Zeilen ein. Stehen vor dem Umbruch weni-
ger Zeilen als im Feld Zeilen angegeben, wird der gesamte Absatz hinter den Umbruch ver-
schoben.

• Hurenkindregelung (Standard: 2): Die Hurenkindregelung ist eine typografische Regel, 
die festlegt, wie viele Zeilen eines Absatzes nach einem Seiten- oder einem Spaltenum-
bruch mindestens stehen müssen. Aktivieren Sie dieses Markierfeld und geben Sie die ge-
wünschte Anzahl in das Feld Zeilen ein. Stehen nach dem Umbruch weniger Zeilen als im 
Feld Zeilen angegeben, wird der Umbruch entsprechend versetzt und es werden leere Zei-
len vor dem Umbruch eingefügt.

Schrift
Über die Seite Schrift (Abbildung 12) legen Sie zusammen mit den Seiten Schrifteffekte und Po-
sition wesentliche Elemente für das Aussehen Ihres Dokumentes fest. Viele der hier beschriebe-
nen Optionen werden auch für die Erstellung neuer Zeichenvorlagen verwendet (s. “Zeichenvorla-
gen“ ab S. 30).

Abbildung 12: Die Absatzvorlage, Seite Schrift.

Die Änderungen beziehen sich auf die aktuelle Auswahl bzw. auf das Wort, in dem sich der Cursor 
befindet, oder aber auf den danach eingegebenen Text.

Je nach Spracheinstellung wird die Formatierung für eine Auswahl der folgenden Schriftarten ge-
ändert:

• Schriftart für westlichen Text - lateinische Zeichensätze.

• Schriftart für asiatischen Text - chinesische, japanische oder koreanische Zeichensätze.

• Schriftart für CTL (Complex Text Layout) - Textlaufrichtung von rechts nach links.
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Tipp
Um die Unterstützung für bidirektionale und ostasiatische Schreibweisen zu akti-
vieren, wählen Sie über das Menü Extras > Optionen... > Spracheinstellungen >
Sprachen und aktivieren die entsprechende Option.

Die Seite Schrift unterteilt sich in mehrere Bereiche.

Schriftart und Schriftschnitt
Im Bereich Schrift wählen Sie aus den installierten Schriftarten die gewünschte Schriftart aus. Im 
unteren Bereich sehen Sie eine Vorschau auf die aktuelle Schriftauswahl.

Die Schriftart lässt sich auch über die Symbolleiste Formatierungen aus der ausklappbaren Aus-
wahlliste Schriftart auswählen (Abbildung 13). Diese Auswahlliste zeigt ebenfalls eine Vorschau, 
wenn unter dem Menüpunkt Extras > Optionen > LibreOffice > Ansicht das Feld Schriftarten-
vorschau aktivieren markiert ist.

Abbildung 13: Schriftartenvorschau der Auswahllis-
te in der Symbolleiste Formatierungen.

Über Menü Format > Zeichen können ebenfalls 
Schrifteinstellungen vorgenommen werden.

Schriftgröße
Im Bereich Größe geben Sie die Schriftgröße ein oder wählen Sie die gewünschte Schriftgröße 
aus. Normalerweise wird die Schriftgröße in pt angegeben (1 pt = 1 Punkt = 0,376 mm). Für ska-
lierbare Schriftarten können Sie auch Dezimalwerte eingeben oder die Größe mit Längeneinheit 
angeben, z. B. cm oder mm.

Relative Schriftgröße
Wenn Sie eine Absatzvorlage auf Grundlage einer anderen Formatvorlage erstellen, haben Sie die
Möglichkeit, die Schriftgröße relativ zu der zugrundeliegenden Formatvorlage festzulegen. Der 
Wert wird in Prozent oder als Point-Wert mit einem „+“- oder „-“-Zeichen angegeben:

• Prozent-Angabe: Ein Prozent-Wert von 150 % bedeutet dann, dass die Schriftgröße in der
abgeleiteten Formatvorlage um 50 % größer ist als die Schriftgröße der verknüpften For-
matvorlage. Betrug die Schriftgröße der verknüpften Formatvorlage 10 pt ist diese in der 
neuen Formatvorlage 15 pt.

• Angabe als Absolutwert in pt: Der Point-Wert wird mit einem „+“- oder „-“-Zeichen ange-
geben. So bedeutet z. B. „-2 pt“ eine Schriftgröße, die um 2 pt kleiner ist als die ursprüngli-
che Formatvorlage; „+5 %“ bedeutet eine um 5 % größere Schriftart.

Dazu ein Beispiel: Sie erstellen eine Absatzvorlage Überschrift 1 mit der Schriftgröße 16 pt.
Für die Absatzvorlage Überschrift 2, die Sie aus der Formatvorlage Überschrift 1 ableiten, 
soll die Schriftgröße 14 pt betragen. Um die Verhältnisse der Schriftgrößen auch bei der 
Änderung der Schriftgrößen beizubehalten, geben Sie für die Absatzvorlage Überschrift 2 
für die Schriftgröße „-2 pt“ ein. Dann ist für die Formatvorlage Überschrift 2 die Schriftgröße
immer 2 pt kleiner.
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Genauso können Sie die Angabe für skalierbare Schriften in Prozent machen, erhalten 
dann aber ungerade pt-Werte: Die Formatvorlage Überschrift 2 hätte bei „-20 %“ dann eine 
Schriftgröße von 

16 pt – 20 % von 16 pt = 16 pt – 3,2 pt = 12,8 pt.

Weitere Optionen zu Zeichenformatierung finden Sie im Abschnitt „Eine neue Zeichenvorlage er-
stellen„ auf Seite 30.

Sprache
Mit der Sprache, die Sie unter Extras > Optionen > Spracheinstellungen > Sprache für Ihr Do-
kument festgelegt haben, bestimmen Sie auch die zu verwendende Rechtschreibprüfung, den 
Thesaurus, die Silbentrennung, die Dezimal- und Tausendertrenner und das Währungsformat.

Notiz
Die Rechtschreibprüfung für die gewählte Sprache funktioniert nur, wenn das ent-
sprechende Sprachmodul installiert ist. Ein Spracheintrag ist mit einem Häkchen 
versehen, wenn die Rechtschreibprüfung für diese Sprache aktiviert wurde.

Für jeden Absatz Ihres Dokumentes können Sie eine separate Sprache einstellen. Diese Einstel-
lung überschreibt die Spracheinstellung, die Sie für das gesamte Dokument getroffen haben.

Die installierten Sprachpakete sind in der Auswahlliste mit einem Symbol versehen - bestehend 
aus einem kleinen ABC und einem Häkchen (Abbildung 14).

Abbildung 14: Die Absatzvorlage, Seite Schrift, installierte Sprachpakete.

Für die Rechtschreibprüfung verwendet Writer für jeden Absatz das zur jeweiligen Sprache gehö-
rende Wörterbuch. Wenn Sie Dokumente in mehreren Sprachen verfassen, können Sie Absatzvor-
lagen für jede Sprache, aber mit sonst gleichen Einstellungen erstellen, so dass Sie mit der Zuwei-
sung eines Textes zu einer Absatzvorlage auch gleich die richtige Sprache festlegen.

Einzelne Wörter einer anderen Sprache werden im Text von der Rechtschreibprüfung markiert. Um
auch hier auf korrekte Rechtschreibung prüfen zu können, markieren Sie das Wort oder die Wörter
und ordnen diesen über die Zeichenformatierung (Menü: Format > Zeichen, Seite Schrift) die 
richtige Sprache zu.

Schrifteffekt
Auf der Seite Schrifteffekte lassen sich die Absätze vielfältig anpassen (Abbildung 15). Hier kön-
nen Sie für einen Absatz verschiedene Zeicheneffekte über Markierfelder oder Auswahllisten ein-
stellen:

• die Schriftfarbe,

• Über-, Unter- und Durchstreichen jeweils mit verschiedenen Linienarten,

• das wortweise Über-, Unter- und Durchstreichen,

• die Farbe für das Über- und Unterstreichen,

• die Schriftdarstellung mit Kontur, SchattenSchatten, blinkend (blinkend ist natürlich nicht auf dem 
Papier erkennbar!) oder (den ausgeblendeten Text können Sie nur sehen, wenn Sie unter 
dem Menüpunkt Extras > Optionen > LibreOffice Writer > Formatierungshilfen das 
Auswahlfeld Versteckter Text im Bereich Anzeigen aktiviert haben),
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• die Schriftdarstellung mit erhabenenerhabenen oder vertieften Reliefvertieften Relief und

• die Schriftdarstellung mit diversen Schrifteffekten: GROSSBUCHSTABEN (nur Grossbuch-
staben), gemeine (nur Kleinbuchstaben), Titel (Jeder Anfangsbuchstabe Wird Groß 
Geschrieben) und KAPTÄLCHEN.

Abbildung 15: Die Absatzvorlage, Seite Schrifteffekt.

Derartige Schrifteffekte werden oftmals nur für einzelne oder einige wenige Worte verwendet. 
Dann sollten Sie diese Worte markieren und über eine Zeichenvorlage formatieren.

Im unteren Bereich dieser Seite sehen Sie eine Vorschau auf das Aussehen der Zeichen. Weitere 
Informationen zu Zeichenvorlagen finden Sie unter ''Zeichenvorlagen“ ab Seite 30.

Position
Auf dieser Seite der Absatzvorlage (Abbildung 16) legen Sie die Position, Skalierung, Rotation und 
Laufweite der Zeichen eines Absatzes fest. Für einzelne oder wenige Zeichen oder Worte sollte die
Formatierung über Zeichenvorlagen erfolgen. Im unteren Teil dieser Seite wird eine Vorschau zu 
den Einstellungen angezeigt.

Üblicherweise wird für einen normalen Text eine Schriftart ohne Hoch- oder Tiefstellungen verwen-
det. Im Bereich Position legen Sie die Optionen für die Hoch- oder Tiefstellung fest:

• Hoch: Verringert die Schriftgröße des ausgewählten Texts und stellt den Text über die 
Grundlinie.

• Normal (Standard): Keine Hoch- oder Tiefstellung.

• Tief: Verringert die Schriftgröße des ausgewählten Texts und stellt den Text unter die 
Grundlinie.

Für die beiden Optionen Hoch und Tief sind weitere Einstellungen möglich:

• Hoch/Tief um: Geben Sie an, um wie viel Prozent der ausgewählte Text in Bezug auf die 
Grundlinie hoch- oder tiefgestellt werden soll. 100 % entspricht dabei der Schrifthöhe.

• Automatisch (Standard): Der Wert, um den der ausgewählte Text in Bezug auf die Grund-
linie hoch- oder tiefgestellt zu stellen ist, wird automatisch festgelegt.

• Schriftgröße rel.: Geben Sie die Prozentzahl ein, um die Sie die Schriftgröße des ausge-
wählten Textes reduzieren möchten.
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Abbildung 16: Die Absatzvorlage, Seite Position.

Im Kapitel 4 Seitenformatierung dieses Handbuches wird die Formatierung von Kopf- und Fußzei-
len mit Hilfe von rotiertem Text beschrieben. Diese Formatierung können Sie auch über separate 
Absatzvorlagen für die Kopf- und Fußzeilen erreichen, wie sie hier beschrieben wird.

In diesem Bereich Rotation/Skalierung legen Sie für den ausgewählten Text Optionen fest, die Ih-
nen erlauben den Text zu drehen oder die Schriftweite zu variieren (Beispiele: Abbildung 17):

• 0 Grad (Standard): Dreht den ausgewählten Text nicht bzw. dreht ihn wieder auf 0 Grad.

• 90 Grad: Dreht den ausgewählten Text um 90 Grad nach links.

• 270 Grad: Dreht den ausgewählten Text um 90 Grad nach rechts.

• Breite skalieren: Geben Sie den Prozentsatz der Schriftweite ein, um welchen der ausge-
wählte Text horizontal gedehnt oder komprimiert werden soll.

Beispiel: Rotierter Text in Absatzvorlagen
Als Beispiel sollen die Überschriften einer bereits bestehenden Tabelle hochkant gestellt werden:

1) Erstellen Sie eine neue Absatzvorlage (Formatvorlagenfenster oder F11) > Rechtsklick auf 
bestehende Absatzvorlage (z. B. Standard) > Aus dem Kontextmenü Neu wählen).

2) Geben Sie der neuen Vorlage einen passenden Namen (z. B. Tabellenüberschrift, rotiert).

3) Auf der Seite Position der neuen Absatzvorlage wählen Sie im Bereich Rotation/Skalie-
rung die Option 90 Grad aus.

4) Speichern und verlassen Sie das Dialogfenster mit OK.

5) Weisen Sie einer Überschrift aus der Tabelle die eben erstellte Absatzvorlage zu.

6) Um die Überschriften nach oben oder unten auszurichten, wählen Sie aus dem Menü Ta-
belle > Tabelleneigenschaften …, Seite Textfluss, Bereich Ausrichtung aus der Auswahl-
liste des Feldes Vertikale Ausrichtung den Eintrag oben oder unten.
Alternativ lässt sich die Ausrichtung über das Menü Format > Ausrichtung und dann im 
unteren Bereich über die Einträge oben oder unten einstellen.

In Abbildung 17 sehen Sie Beispiele für einen 
Text, der um 0°, 90° und 270° rotiert wurde.

Abbildung 17: Beispiele für rotierten Text.
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Im Bereich Abstand lässt sich der Abstand zwischen den einzelnen Zeichen festlegen. Aus der 
Auswahlliste Abstand können Sie den Zeichenabstand wählen:

• Standard: Es wird die für die Schriftart festgelegte Laufweite verwendet.

• Gesperrt: Der Abstand zwischen den Zeichen wird vergrößert.

• Schmal: Der Abstand zwischen den Zeichen wird verringert.

• um (Standard: 0): Das Feld ist nur für die Abstände Gesperrt und Schmal zugänglich. Die 
Angabe in pt (Punkt) legt fest, mit welcher Laufweite (Zeichenabstand) der Absatz ausge-
dehnt oder komprimiert werden soll.

• Paarweises Kerning (= Unterschneidung; Standard: ein): Kerning/Unterschneidung ist ein 
typografischer Begriff und passt den Zeichenabstand für bestimmte Buchstabenkombinatio-
nen automatisch an. Durch Unterschneidung von Zeichen verbessert sich die Lesbarkeit ei-
nes Textes (Abbildung 18). Kerning ist nur für bestimmte Schriftarten verfügbar und muss 
auch vom jeweiligen Drucker unterstützt werden.

Abbildung 18: Beispiel für Paarweises Kerning:
ausgeschaltet (links) und eingeschaltet 
(rechts). 

Tabulatoren
Im Dialogfenster für die Absatzvorlagen können Sie die Art und Position der Tabulatoren für einen 
Absatz festlegen (Abbildung 19). Mit Tabellen lassen sich Texten, Abbildungen, Formeln und ande-
re Objekte entsprechend den eigenen Vorstellungen auf einer Seite anordnen. Die Tabellen kön-
nen dabei mit oder ohne Rahmen angezeigt werden. Oftmals sind Tabulatoren jedoch für die For-
matierung ausreichend. Sie lassen sich einfacher erstellen und flexibel handhaben.

Um Tabulatoren für einen Absatz zu setzen, müssen Sie die Position, die Art des Tabulators, die 
Füllzeichen bis zum Text festlegen und die Schaltfläche Neu drücken. Die Positionsangabe erfolgt 
in cm, wenn keine Maßeinheit angegeben wird. Sie können auch andere Maßeinheiten wie z. B. 
mm oder Zoll angeben. Der Abstand wird zum linken Rand gemessen. Leider ist es nicht möglich, 
bereits definierte Tabulatoren zu ändern. Diese müssen Sie löschen und dann neu mit den ge-
wünschten Parametern festlegen. Bereits vorhandenen Tabulatoren werden im unteren Teil des 
Bereiches Position angezeigt.
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Abbildung 19: Die Absatzvorlage, Seite Tabulatoren.

Achtung

Wenn Sie ein Dokument mit Tabulatoren zur Formatierung an andere Beteiligte im 
odt-Format verschicken, verwenden Sie nicht die Standardeinstellung für Tabulato-
ren, sondern setzen Sie eigene Tabulatoren. Ansonsten kann das Dokument ein 
ganz anders Aussehen bekommen, wenn der Empfänger andere Standardabstän-
de für seine Tabulatoren eingestellt hat. Um dasselbe Layout zu erhalten, definie-
ren Sie deshalb in den verwendeten Absätzen oder Absatzformatvorlagen die not-
wendigen Tabulatorabstände.

Die Ausrichtung eines Textes oder von Zahlen richtet sich nach der Art des Tabulators (Beispiele  
siehe Abbildung 20):

Abbildung 20: Beispiel für linke, rechte, zentrierte und Dezimaltabu-
latoren.

• Links (Standard): Der Text wird linksbündig am Tabulator ausgerichtet.

• Rechts: Der Text wird rechtsbündig am Tabulator ausgerichtet.

• Zentriert: Der Text wird zentriert am Tabulator ausgerichtet.

• Dezimal: Der Dezimaltrenner einer Zahl (z. B. das Komma in der Zahl 123,45) wird mittig 
am Tabulator ausgerichtet. Reiner Text wird links davon ausgerichtet. Das als Dezimaltren-
ner verwendete Zeichen wird von der Gebietseinstellung des jeweiligen Betriebssystems 
vorgegeben.

◦ Zeichen: Hier können Sie ein anderes Zeichen eingeben, dass als Dezimaltrenner für
den Tabulator verwendet werden soll.

Beispiele für die Ausrichtung des Textes an den verschiedenen Tabulatorarten und für Füllzeichen 
sehen Sie in Abbildung 20.

Füllzeichen vor Tabulatoren verwenden Sie z. B. für Formulare zur Eingabe von Text, für Inhalts-
verzeichnisse oder Sachregister. Im Bereich Füllzeichen können Zeichen ausgewählt werden, die 
den Zwischenraum bis zum nächsten Text ausfüllen.
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• Keine: Es werden keine Füllzeichen eingesetzt. Vorhandene Füllzeichen links neben dem 
Tabulator werden gelöscht.

• .......: Der Leerraum links des Tabulators wird mit Punkten aufgefüllt.

• ------: Der Leerraum links des Tabulators wird mit Minuszeichen aufgefüllt.

• ____: Der Leerraum links des Tabulators wird mit einer durchgezogenen Linie aufgefüllt.

• Zeichen: Der durch den Tabulator frei gehaltene Leerraum wird mit dem von Ihnen vorge-
gebenen Zeichen aufgefüllt.

Notiz
Es ist nicht möglich, Tabulatoren außerhalb der Seitenränder zu definieren. Falls 
das notwendig sein sollte, so verwenden Sie dazu Tabellen oder Rahmen ohne 
Umrandung.

Gliederung & Nummerierung
Die Seite Gliederung & Nummerierung (Abbildung 21) ermöglicht Ihnen Absätze zu nummerieren
oder mit Aufzählungszeichen zu versehen, wie z. B. Überschriften oder Listen. Die Art der Numme-
rierung oder Aufzählungszeichen kann in Listenvorlagen festgelegt werden.

Abbildung 21: Die Absatzvorlage, Seite Gliederung & Nummerierung.

Tipp

Möchten Sie ein Dokument mit Gliederung und Inhaltsverzeichnis erstellen, wie 
z.B. eine wissenschaftliche Arbeit oder ein Buch, so sollten Sie eine Unterteilung in
Kapitel vornehmen. Dazu ordnen Sie unter dem Menüpunkt Extras > Kapitelnum-
merierung ..., Seite Nummerierung den einzelnen Gliederungsebenen eine Ab-
satzvorlage zu, beispielsweise der Gliederungsebene 1 die Absatzvorlage Über-
schrift 1. Daneben können Sie für die Gliederungsebenen den Einzug, die Aus-
richtung und den Abstand der Nummerierung zum Text festlegen.

Im Bereich Gliederung legen Sie über das Auswahlfeld Gliederungsebene die Ebene fest, die 
dem Absatz zugeordnet werden soll. So ist die in Writer vordefinierte Absatzvorlage Überschrift 1 
der Ebene 1 und die Absatzvorlage Überschrift 2 der Ebene 2 zugeordnet.

Die aus dem Bereich Aufzählung/Nummerierung auszuwählende Listenvorlage müssen vorher 
als Listen- oder Nummerierungsvorlagen definiert worden sein. Wenn Sie in einem Absatz Listen 
oder Aufzählungen bestimmte Formatierungen zuweisen wollen:

• Erstellen Sie eine neue Listenvorlage (s. Neue Listenvorlagen erstellen, Seite 51).

• Selektieren Sie aus der Auswahlliste Listenvorlage die neue erstellte Vorlage. 
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• Speichern Sie die Einstellung mit OK.

Weiterführende Informationen und ein Beispiel für diese Zuordnung finden Sie unter Beispiel: Er-
stellen einer einfachen Liste auf der Seite 59.

Im Bereich Zeilennummerierung stehen Ihnen mehrere Optionen zu Verfügung:

• Die Zeilen des Absatzes mitzählen (Standard: Aktiviert): Wenn Sie in einem Dokument 
Zeilen nummerieren möchten, so können Sie durch deaktivieren dieses Feldes die ausge-
wählte Absätze (die vorher markierten Absätze) von der Zeilennummerierung ausschlie-
ßen.

• An diesem Absatz neu beginnen (Standard: Nicht aktiviert): An diesem Absatz beginnt 
die Zeilennummerierung neu.

◦ Beginnen mit: Legen Sie die Zeilennummer fest, mit der eine neue Zeilennummerie-
rung begonnen werden soll.

Initialen
Die Verwendung von Initialen ist vielfach aus Büchern oder Romanen bekannt. Auf der Seite Initia-
len (Abbildung 22) legen Sie die Eigenschaften der Initialen fest, die sich auch über mehrere Zei-
len erstrecken kann:

Abbildung 22: Die Absatzvorlage, Seite Initialen.

In den Bereich Einstellungen und Inhalt stehen mehrere Optionen zur Verfügung, deren Auswirkun-
gen im Vorschaufenster im rechten Teil der Seite zu sehen sind:

• Initialen anzeigen (Standard: Nicht aktiviert): Schaltet die Initialen für den ausgewählten 
Absatz ein.

• Ganzes Wort: Zeigt den Anfangsbuchstaben des ersten Wortes im Absatz als Initiale und 
den Rest des Wortes in Großdruck an.

• Anzahl der Zeichen (Standard: 1): Legt fest, wie viele Zeichen in Initialen umgewandelt 
werden sollen. Das Feld ist nicht verfügbar, wenn die unterstehende Option Ganzes Wort 
aktiviert ist.

• Zeilen (Standard: 3): Legt fest, über wie viele Zeilen sich die Initiale von der ersten Zeile im
Absatz aus nach unten erstrecken soll. Absätze mit weniger Zeilen können nicht mit Initia-
len versehen werden. Die Auswahl ist auf 2 bis 9 Zeilen beschränkt.

• Abstand zum Text (Standard: 0): Abstand zwischen den Initialen und dem restlichen Text 
im Absatz.

• Text: Geben Sie den Text ein, der statt den Anfangsbuchstaben des Absatzes als Initialen 
angezeigt werden soll.

• Zeichenvorlage (Standard: Keine): Wählen Sie die Zeichenvorlage aus, die Sie für die In-
itialen verwenden möchten. Über die Formatvorlagen, die vorher definiert sein müssen, 
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können Sie das Aussehen der Initialen weiter beeinflussen, wie die Farbe, das Schriftenre-
lief oder andere Schrifteffekte. Um die Formatvorlage des aktuellen Absatzes zu verwen-
den, wählen Sie im Feld „Auswahlliste“ den Eintrag „[keine]“ aus.

Hintergrund
Dieser Abschnitt verhält sich ein wenig anders, als in der 4.0 Version. In der Absatzvorlage Stan-
dard kann im Reiter Fläche die Hintergrundfüllung definiert werden.

Über diese Seite lässt sich der Hintergrund eines Absatzes festlegen, z. B. für Prospekte oder Bro-
schüren. Auch die Hervorhebung durch farbliche Gestaltung oder dekorative Grafikelemente kön-
nen Sie damit realisieren. Für den Hintergrund kann wahlweise eine Farbe oder eine Grafik ge-
wählt werden.

Der Hintergrund wird nur auf den Absatzbereich (Textbereich) angewendet. Wenn Sie einen einge-
rückten Absatz festgelegt haben, wird der Raum zwischen dem Absatz und dem Rand keine Hin-
tergrundfarbe aufweisen.

• Als: Auswahl, ob der Hintergrund als Farbe, Verlauf, Schraffur oder als Grafik dargestellt 
wird.

Farbe
Abbildung 23 zeigt die Seite Fläche für die Auswahl Farbe. Die vordefinierten Farben lassen sich 
über das Menü Extras > Optionen ... > LibreOffice > Farben durch selbstdefinierten Farben er-
gänzen. Die Hintergrundfarbe ist für den Hintergrund eines Absatzes definiert. Bei eingezogenen 
Absätzen wird Raum zwischen dem Absatz und dem Rand nicht farblich hinterlegt. Im Feld Für ha-
ben Sie die Auswahl:

Abbildung 23: Die Absatzvorlage, Seite Fläche, Auswahl Farbe.

• Absatz: Die aus der Farbpalette ausgewählte Farbe färbt den Hintergrund vom linken bis 
zum rechten Seitenrand.

• Zeichen: Die aus der Farbpalette ausgewählte Farbe färbt nur den Zeichenhintergrund.

Grafik
 Abbildung 24 zeigt die Seite Fläche mit der Auswahl Bitmap. Weitere Informationen zur Arbeit mit
Grafiken als Hintergrund finden Sie auch in der Dokumentation zu LibreOffice Impress.

• Durchsuchen: Über die Schaltfläche Durchsuchen wählen Sie die Datei für die Hinter-
grunddatei aus. Nach der Auswahl der Datei erscheint im rechten Vorschaufenster eine 
Voransicht der Datei.

• Verknüpfung: Stellt eine Verknüpfung zur Grafikdatei her oder bettet sie in die aktuelle Da-
tei als Hintergrund ein. Das unterstehende Textfeld (unten mit 'unverknüpfte Grafik' be-
zeichnet) zeigt den Pfad und Dateinamen der verknüpften Grafikdatei an.
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◦ Art: Hier wird angegeben, wie die Grafik als Hintergrundbild angezeigt werden soll.

◊ Position: Wählen Sie diese Option aus, und klicken Sie auf eine Stelle im Positi-
onsraster.

◊ Fläche: Dehnt die Grafik über die gesamte Hintergrundfläche des ausgewählten 
Objekts aus.

◊ Nebeneinander: Die Hintergrundfläche des ausgewählten Objekts wird durch 
mehrmalige Wiederholung der Grafik kachelartig ausgefüllt.

Abbildung 24: Die Absatzvorlage, Seite Fläche, Auswahl Bitmap.

Umrandung
Mit Umrandungen können Sie Seiten, Absätze, Texte, Rahmen, Tabellen, Grafiken, besondere Hin-
weise u. ä. hervorheben. So werden Umrandungen oftmals als Abgrenzung für Kopf- und Fußzei-
len vom eigentlichen Text genutzt, wie Sie es auch in der Fußzeile dieser Dokumentation sehen. 
Die farbliche Gestaltung einer Umrandung kann zusätzlich Elemente dekorativ hervorheben.

Für die Umrandung können Sie die Position, Größe, Farbe, Linienart und -breite (Stil) u. a. Eigen-
schaften der Umrandung vorgeben. Achten Sie auch darauf, dass der Abstand zwischen der Um-
randung und dem Absatzbereich durch Einzüge und Tabulatoren beeinflusst wird.

Tipp

Wenn Sie die Umrandung einer ganzen Tabelle in Ihrem Text ändern möchten, set-
zen Sie den Cursor in eine Tabellenzelle, nach einem Rechtsklick wählen Sie aus 
dem Kontextmenü Tabelle und die Seite Umrandung. Um nur die Umrandung ei-
ner Tabellenzelle zu ändern, wählen Sie die Zelle aus, klicken dann mit der rech-
ten Maustaste und wählen Tabelle und schließlich die Seite Umrandung.

Die Seite Umrandung ist in mehrere Bereiche unterteilt (Abbildung 25):
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Abbildung 25: Die Absatzvorlage, Seite Umrandung.

Bereich Linienanordnung:

• Standard: Hier können Sie aus mehreren vordefinierte Standardumrandungen wählen. Die
dunklen Linien innerhalb eines Symbols zeigen die Linien an, die in dem gewählten Stil und
in der gewählten Farbe eingefügt werden.

• Benutzerdefiniert: Hier wird die Auswahl, die mit Standard getroffen wurde, als Vorschau 
angezeigt. Zusätzlich können Sie auch durch Klicken auf die Linienbereiche (durch kurze 
graue Linien angedeutet) einzelne Linien hinzufügen oder entfernen. Die Vorschau zeigt 
die Linien in drei unterschiedlichen Zuständen an (Abbildung 26):

◦ Schwarze Linie: Die Linie wird an der ausgewählten Position eingefügt (Abbildung 
26 a).

◦ Graue Linie: An dieser Position kann keine Linie hinzugefügt oder entfernt werden 
(Abbildung 26 b).

◦ Weiße Linie: An dieser Position wird die Linie entfernt (Abbildung 26 c).

   a)    b)    c)

Abbildung 26: Benutzerdefinierte Linienanordnung: a) Linie wird ein-
gefügt, b) Linie kann nicht geändert werden und c) Linie wird ent-
fernt.

Bereich Linie:

• Stil: Wählen Sie aus dem Auswahlliste die Linienart aus.
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• Breite: Legen Sie die Breite der ausgewählten Linien fest.

• Farbe: Weisen Sie einer oder mehreren Linien eine Farbe zu.

Notiz

Das stärkere Attribut hat stets Vorrang vor dem schwächeren Attribut. Beispiel: 
Eine Zelle einer Tabelle besitzt eine 2 Punkt breite rote Umrandung und die be-
nachbarte Zelle eine blaue 3 Punkt breite Umrandung. In diesem Fall ist die ge-
meinsame Grenze zwischen beiden Zellen blau und 3 Punkt breit.

Bereich Abstand zum Inhalt: Geben Sie an, wie viel Freiraum zwischen dem Rand und dem Inhalt 
der Auswahl (dem Text) bleiben soll.

• Links (Standard: 0,05 cm): Abstand zwischen dem linken Rand und dem Inhalt der Aus-
wahl.

• Rechts (Standard: 0,05 cm): Abstand zwischen dem rechten Rand und dem Inhalt.

• Oben (Standard: 0,05 cm): Abstand zwischen dem oberen Rand und dem Inhalt.

• Unten (Standard: 0,05 cm): Abstand zwischen dem unteren Rand und dem Inhalt.

• Synchronisieren (Standard: Aktiviert): Zu allen vier Rändern wird der gleiche Abstand ein-
gestellt. Nur in einem Feld kann der Abstand eingegeben werden.

Bereich Schatten: Sie können einer Umrandung auch einen Schatteneffekt zuweisen. Am besten 
wirkt dieser Effekt, wenn alle vier Ränder sichtbar sind.

• Position: Hier legen Sie die Position des Schattenwurfs fest. Der Standard ist kein Schat-
tenwurf.

• Distanz (nur verfügbar, wenn ein Schattenwurf ausgewählt wurde): Gibt die Schattenbreite 
in cm an.

• Farbe (nur verfügbar, wenn ein Schattenwurf ausgewählt wurde): Auswahl der Farbe des 
Schattens.

Notiz

In einem Textrahmen verankerte Grafiken oder Objekte in einem Dokument sind 
auf die Größe dieses Textrahmens begrenzt. Wenn Sie auf die Ränder eines Ob-
jekts, das einen ganzen Textrahmen ausfüllt, einen Schatteneffekt anwenden, wird 
das Objekt so weit verkleinert, dass auch der Schatten im Rahmen Platz findet.

Bereich Eigenschaften:

• Mit dem nächsten Absatz verschmelzen (Standard: Aktiviert): Verschmilzt die Umran-
dungs- und die Schattierungsvorlage des aktuellen Absatzes mit den Vorlagen des nächs-
ten Absatzes. Diese Vorlagen werden nur dann verschmolzen, wenn die Vorlagen für Ein-
zug, Umrandung und Schattierung für den aktuellen und den nächsten Absatz gleich sind.

Arbeiten mit bedingten Absatzvorlagen

Durch die Zuweisung einer bedingten Absatzvorlage zu einem Dokument ist es möglich, den ein-
zelnen Elementen (Kontext) Ihres Dokuments, wie Tabellen, Rahmen, Kopfzeile, Fußzeile oder 
Gliederungsebene, jeweils eigene Formatierungen zuzuweisen. Die den Elementen zugewiesenen 
Absatzvorlagen können auch eigene, vorher definierte Vorlagen sein. Die bedingte Absatzvorlage 
fungiert sozusagen als übergeordnete Vorlage und ermöglicht die einheitliche Gestaltung von Do-
kumenten, z. B. eines Geschäftsbriefes. Die Formatierungen für den eigentlichen Text erfolgt auf 
den Seiten der bedingten Absatzvorlage. Werden den Elementen Ihres Dokuments keine Vorlagen 
zugeordnet, so werden die Formatierungen der bedingten Vorlage verwendet.
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Achtung Eine Absatzvorlage kann nur bei erstmaligen Erstellung als bedingte Absatzvorla-
ge definiert werden. Nach dem Schließen über die Schaltfläche OK ist die Seite 
Bedingung nicht mehr sichtbar und zugänglich.

Ein Beispiel soll das Vorgehen und die Auswirkungen verdeutlichen:

1) Öffnen Sie ein leeres Textdokument und schreiben Sie einen kurzen Text als Geschäfts-
brief mit einer Kopf- und Fußzeile (Format > Seite > Kopfzeile bzw. Format > Seite > 
Fußzeile).

2) In der Absatzvorlage Kopfzeile stellen Sie den Hintergrund auf die Farbe blau.

3) In der Absatzvorlage Fußzeile stellen Sie den Hintergrund auf die Farbe rot.

4) Definieren Sie eine neue Absatzvorlage, indem Sie aus dem Kontextmenü des Fensters 
Formatvorlagen den Befehl Neu... wählen und im Dialogfenster der Absatzvorlage alle Ab-
satzeigenschaften festlegen, die Sie in Ihrem Geschäftsbrief für normale Absätze bevorzu-
gen. Geben Sie dieser Vorlage auf der Seite Verwalten den Namen "Geschäftsbrief". Ach-
tung! Bestätigen Sie nicht mit OK.

5) Wechseln Sie auf die Seite Bedingung, und markieren Sie das Feld Als bedingte Vorla-
ge, um die neue Absatzvorlage als bedingte Vorlage zu definieren (Abbildung 27).

6) Unter Inhalt wählen Sie nun den Eintrag Kopfzeile und im Listenfeld Absatzvorlagen die 
Vorlage, die für die Kopfzeile in Ihrem Geschäftsbrief gelten soll, also z. B. die vorgegebe-
ne Absatzvorlage Kopfzeile (Abbildung 27). Natürlich können Sie hier auch eine vorher 
selbstdefinierte Vorlage auswählen.

7) Unter Inhalt wählen Sie nun den Eintrag Fußzeile und im Listenfeld Absatzvorlagen die 
Vorlage, die für die Fußzeile in Ihrem Geschäftsbrief gelten soll, also z. B. die vorgegebene
Absatzvorlage Fußzeile (Abbildung 27). Natürlich können Sie hier auch eine vorher selbst-
definierte Vorlage auswählen.

8) Durch einen Klick auf die Schaltfläche Zuweisen oder durch Doppelklick auf den Eintrag 
im Listenfeld Absatzvorlagen, ordnen Sie die Vorlage dem Kontext zu (Abbildung 27).

9) Schließen Sie das Dialogfenster Absatzvorlagen mit OK, und formatieren Sie alle Absätze
Ihres Geschäftsbriefs, einschließlich der Kopf- und Fußzeile, mit der neuen bedingten Ab-
satzvorlage "Geschäftsbrief". (Wenn Sie in die Kopf-/Fußzeile klicken, kann es gegebenen-
falls nötig sein, sich alle Vorlagen oder die Benutzervorlagen im Fenster Formatvorlagen 
anzeigen zu lassen, um die neue Vorlage "Geschäftsbrief" anwenden zu können.)

10) Die Kopf-/Fußzeile sollte jetzt blau/rot dargestellt werden.

Auf der Seite Bedingung finden Sie weitere Bedienelemente:

• Bedingte Vorlage (Standard: Nicht aktiviert): Mit der Aktivierung dieser Option definieren 
Sie die neue Vorlage als bedingte Vorlage.

• Inhalt: Vordefinierte Elemente (Kontext) ihres Dokuments, denen Sie Absatzvorlagen zu-
ordnen können.

• Verwendete Vorlagen: Auflistung aller einem Kontext zugewiesenen Absatzvorlagen.

• Absatzvorlagen: Auflistung aller Absatzvorlagen, die Sie einem Kontext zuordnen können.

• Vorlagengruppen: Die Formatvorlagen sind den Vorlagengruppen zugeordnet.

Name Bedeutung

Automatisch Anzeige der zum aktuellen Kontext passenden Vorlagen.

Alle Vorlagen Zeigt alle Vorlagen des aktuellen Vorlagentyps.

Verwendete Vorlagen Zeigt die Formatvorlagen (aus der ausgewählten Kategorie) an, die
im aktuellen Dokument verwendet werden.

Benutzervorlagen Zeigt die vom Benutzer definierten Vorlagen des aktuellen Vorla-
gentyps.
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Name Bedeutung

Zeichenvorlagen Zeigt die Formatvorlagen für Text an.

Kapitelvorlagen Zeigt die Formatvorlagen für Überschriften an.

Listenvorlagen Zeigt die Formatvorlagen für nummerierte Listen oder Listen mit 
Aufzählungszeichen an.

Verzeichnisvorlagen Zeigt die Formatvorlagen für Verzeichnisse an.

Vorlagen Sonderbe-
reiche

Zeigt die Formatvorlagen für Kopf- und Fußzeilen, Fuß- und End-
noten, Tabellen und Beschriftungstext an.

HTML-Vorlagen Zeigt die Vorlagen für HTML-Dokumente.

Bedingte Vorlagen Zeigt die von Ihnen definierten bedingten Vorlagen.

Hierarchisch Zeigt die Vorlagen der ausgewählten Kategorie in einer hierarchi-
schen Liste an. Um die Vorlagen einer Unterebene anzuzeigen, kli-
cken Sie auf das Pluszeichen (+) neben dem Namen der betreffen-
den Unterebene.

Abbildung 27: Die Absatzvorlage, Seite Bedingung.

• Entfernen: Klicken Sie hier, um die aktuell markierte Zuweisung von Kontext und verwen-
deter Vorlage zu entfernen.

• Zuweisen: Klicken Sie auf die Schaltfläche, um die ausgewählte Absatzvorlage als ver-
wendete Vorlage dem zuvor ausgewählten Kontext zuzuweisen.
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Zeichenvorlagen

Mit Hilfe von Zeichenvorlagen werden die Formatierungsmöglichkeiten innerhalb eines Absatzes 
erweitert. Die Zeichenvorlagen werden auf einzelne oder mehrere Zeichen, Wörter oder Sätze an-
gewandt, aber gewöhnlicherweise nicht auf den ganzen Absatz. Beispielsweise lassen sich damit 
Zeichen oder Wörter kursiv, fett oder farbig hervorheben.

In diesem Dokument werden u. a. die Zeichenvorlagen verwendet:

• LibOTaste: Eine Zeichenvorlage aus der Vorlagengruppe 'Benutzervorlagen', die die mar-
kierten Zeichen/Wörter kursiv stellt.
Beispieltext mit angewandter Zeichenvorlage: Drücken Sie die Tastenkombination Um-
schalt+Strg+J.

• LibOMenüPfad: Eine Zeichenvorlage aus der Vorlagengruppe 'Benutzervorlagen', die die 
markierten Zeichen/Wörter fett darstellt.
Beispieltext mit angewandter Zeichenvorlage: Diese Einstellung können Sie über das Menü
Extras > Optionen > LibreOffice > Farben ändern.

Weitere Anwendungsmöglichkeiten werden an verschiedenen Stellen des Writer Handbuches be-
schrieben, z. B. bei der Kapitel-, Seiten- oder Listennummerierung, der Hervorhebung von Hyper-
links.

Die Verwendung von Wörtern aus anderen Sprachen oder von Programmiersprachen wird Writer 
diese bei eingeschalteter Rechtschreibprüfung (s. Absatzvorlagen, Textfluss, S. 13) als fehlerhaft 
markieren. Um das zu vermeiden, definieren Sie eine Zeichenvorlage, legen die zutreffende Spra-
che fest und ordnen Sie diese Vorlage den Wörtern zu.

Vorteile von Zeichenvorlagen
Viele Anwender von Writer fragen sich „Warum soll ich Zeichenvorlagen verwenden?“ oder „Was 
unterscheidet Zeichenvorlagen vom Klicken auf das Icon für Fettschrift?“ Ein kleines Beispiel soll 
das erläutern:

Michaela schreibt ein Buch und lernt dabei die Vorteile der Zeichenvorlagen kennen.
Das fertige Manuskript schickt sie zum Verleger, der von ihre aber verlangt, dass die
in ihrem 200-seitigen Text vorkommenden Menüpfade nicht fett gedruckt werden 
sollen. Da sie keine Zeichenvorlage dafür benutzt hat, muss sie alle 200 Seiten per 
Hand mittels Suchen & Ersetzen editieren. Das war das letzte Mal, dass sie keine 
Zeichenvorlagen benutzt hat.

Die Vorteile der Zeichenvorlagen sind u. a.:

• Formatierungsänderungen: Wie das obige Beispiel zeigt, können Änderungen für das ge-
samte Dokument erfolgen.

• Konsistente Änderungen: Die Änderungen sind im ganzen Dokument gleich und es las-
sen sich einheitliche Formatierungsrichtlinien erstellen.

• Konzentration auf den Inhalt: Der Autor muss nicht jedes Mal neu darüber nachdenken, 
wie z. B. Menüpfade oder Tastaturkürzel hervorgehoben werden sollen. Eine entsprechen-
de Bezeichnung der Vorlage erleichtert die Arbeit und befreit den Autor von aufwändigen 
Formatierungsarbeiten.

Eine neue Zeichenvorlage erstellen
In diesem Abschnitt werden die Erstellung einer neuen Zeichenvorlage und die Einstellmöglichkei-
ten auf den Registerseiten der Zeichenformatvorlage beschrieben. Viele der Seiten wurden schon 
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in Zusammenhang mit den Absatzvorlagen (s. Absatzvorlagen ab S. 9) behandelt. Während die 
Seiten Schrift (s. Abschnitt Schrift, S. 15), Schrifteffekte (s. Abschnitt Schrifteffekt, S. 17) und Po-
sition (s. Abschnitt Position, S. 18) identisch sind, unterscheiden sich die Seiten Hintergrund (s. 
Abschnitt Hintergrund, S. 24) und Umrandung (Umrandung, S. 25) ein wenig:

• Hintergrund: Hier können Sie nur eine Hintergrundfarbe auswählen. Die Auswahl als Gra-
fik ist für ein Zeichen nicht sinnvoll.

• Umrandung: Das Optionsfeld Mit dem nächsten Absatz verschmelzen ist nicht vorhan-
den und für ein Zeichen auch nicht sinnvoll.

An dieser Stelle wird daher nur die Erstellung einer Zeichenformatvorlage erläutert:

• Öffnen Sie das Fenster Formatvorlagen (über die Funktionstaste F11, das Menü Format > 
Formatvorlagen oder das Symbol  oder ).

• Wählen Sie die Zeichenvorlagen  und daraus eine Vorlage, die als Grundlage für Ihre neue 
Zeichenvorlage dienen soll, z. B. Standard. Mit der rechten Maustaste öffnen Sie das Kon-
textmenü und wählen Neu.

• Im sich öffnenden Dialogfenster Zeichenvorlage können Sie auf den einzelnen Seiten Än-
derungen an den Einstellungen vornehmen.

• Auf der Seite Verwalten geben Sie der Vorlage eine aussagekräftige Bezeichnung, die bei-
spielsweise die Verwendung beschreibt, wie etwa MenüPfad.

• Über die Seite Schrift ändern Sie den Schriftsatz, die Schriftart und deren Größe, die so-
wohl als Absolutwert in pt oder einer Längeneinheit (mm, Zoll) als auch in Prozent angege-
ben werden kann. Im Abschnitt Relative Schriftgröße auf der Seite 16 dieses Handbuches 
finden Sie dazu weitergehende Informationen und Beispiele. Sie können hier auch die 
Sprache für einzelne Wörter oder Zeichen festlegen, so dass sie von der entsprechenden 
Rechtschreibprüfung erkannt und nicht als falsch geschrieben angezeigt werden.

• Die Seite Schrifteffekte enthält verschiedene Schriftauszeichnungen, die Sie für einzelne 
Wörter oder Zeichen verwenden können, wie Schriftfarbe, Über-, Unter- oder Durchstrei-
chungen, Konturen, Reliefs, Kapitälchen, verborgene Schrift u.a.

• Einstellungen auf der Seite Position legen die Position (Hoch-/Tiefstellung), Skalierung, 
Rotation und Laufweite von Zeichen fest.

• Zum Schluss können Sie noch auf der Seite Hintergrund einen farblichen Hintergrund für 
die ausgewählten Zeichen oder Wörter festlegen, sowie über das Register Umrandung 
den Text mit linienartigen Abgrenzungen hervorheben.

Zeichenvorlagen statt manueller Formatierung
Viele Anwender von Writer formatieren ihren Text manuell über die Symbolleiste. Die Vorteile einer 
schnellen und durchgängigen Änderung durch Formatvorlagen wurden bereits erläutert (s. Ab-
schnitt „Vorteile von Zeichenvorlagen'', S. 30). Dazu einige Hinweise zum einfacheren Übergang 
von der manuellen Formatierung zur Verwendung von Formatvorlagen:

• Mischen Sie keine Zeichenvorlagen und manuelle Formatierung: Die manuelle Forma-
tierung überschreibt die Zeichenvorlagen. Wenn Sie beide vermischen kann das zu uner-
wünschten Formatierungen führen (Formatierungsdschungel) und Sie verschwenden viel 
Zeit, um herauszufinden, warum Ihre Zeichenvorlage nicht funktioniert.

• Entfernen Sie die manuelle Formatierung: Mit einem Rechtsklick auf die ausgewählten 
Zeichen oder Wörter wählen Sie aus dem Kontextmenü Direkte Formatierung entfernen 
oder über das Menü Format > Direkte Formatierung entfernen oder über die Tastenkom-
bination Strg+M. Damit werden alle manuellen Formatierungen, die Sie über das Menü 
oder die Symbolleiste durchgeführt haben, entfernt, nicht aber die Formatvorlagen. Um 
auch die Zeichenformatierung über Formatvorlagen zu entfernen, weisen Sie den markier-
ten Zeichen oder Wörtern die Zeichenformatvorlage Standard zu.
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• Lassen Sie das Fenster Formatvorlagen (über die Funktionstaste F11, das Menü Format >
Formatvorlagen oder das Symbol  oder  in der Symbolleiste Format zu erreichen) of-
fen oder docken Sie es an den rechten oder linken Rand, dann können Sie schnell und ein-
fach auf die Formatvorlagen zugreifen.

• Übernehmen Sie bereits erstellte und im aktuellen Dokument wiederzuverwendende For-
matvorlagen aus anderen Dokumenten.

• Ein Doppelklick auf eine vorhandene Formatvorlage im offenen Formatvorlagenfenster ist 
genauso einfach, wie ein Klick auf ein Symbol in der Symbolleiste, z.B. um markierte Zei-
chen oder Wörter fett darzustellen.

Rahmenvorlagen

Rahmen werden oft als Container für Text oder Grafik verwendet. Die Verwendung von Rahmen-
vorlagen ermöglicht Ihnen, das Layout, die Position, den Abstand der Rahmenbegrenzung zum ei-
gentlichen Inhalt und weitere Formatierungen festzulegen, um ein einheitliches Erscheinen ihres 
Dokumentes zu erreichen. Wenn Sie Fotos mit einem dekorativen Rand versehen wollen, so plat-
zieren Sie das Foto in einen Rahmen und können den Rahmen entsprechend Ihren Vorstellungen 
gestalten. Dieser Rahmen lässt sich über die gesamte Seite verschieben, auch über den Seiten-
rand hinaus. Bei einer Fotosammlung soll dieser Rahmen sicherlich für weitere Fotos verwendet 
werden. Dafür ist es vorteilhaft eine Rahmenvorlage zu verwenden. Diese kann dann den gestalte-
ten Rahmen beinhalten und in der Größe variabel sein.

Writer bietet Ihnen schon einige vordefinierte Rahmenvorlagen an, die Sie modifizieren können 
oder Sie erstellen sich bei Bedarf neue Rahmenvorlagen. Neue Rahmenvorlagen sind ähnlich zu 
erstellen, wie Absatz- oder Zeichenvorlagen.

Tipp
Bei der Seitenformatierung können Rahmen und Bereichen verwendet werden. 
Zwischen beiden gibt es einige Überschneidungen. In Kapitel 4 „Seitenformatie-
rung“ können Sie sich darüber informieren.

Besonderheiten von Rahmenvorlagen
Beim Einfügen von Objekten in Writer werden diese automatisch mit einem vordefinierten Rahmen
versehen, dabei wird auch die Position ermittelt und die Beziehung zu anderen Elementen des Do-
kumentes berücksichtigt. Nach der Einbettung des Objektes können Sie die Eigenschaften des 
Rahmens modifizieren.

Weil Objekt und Rahmen gleichzeitig erstellt werden, ist es manchmal einfacher, beide als Einheit 
zu betrachten. In anderen Fällen, z. B. bei Diagrammen, kann es sinnvoll sein, Rahmen und Objekt
separat bearbeiten zu können.

Im Gegensatz zu anderen Formatvorlagen, wie Absatz- oder Zeichenvorlagen, können in Rahmen-
vorlagen nicht alle Eigenschaften vorher definiert werden. So können beispielsweise die Veranke-
rungen des Rahmens, die Anordnung gegenüber anderen Objekten oder die Anordnung zum Text 
im Dokument erst nach der Erstellung festgelegt werden. Zudem sind diese Einstellungen nur ma-
nuell und für jeden Rahmen einzeln durchzuführen.

Sie können über das Menü Einfügen > Rahmen einen Rahmen neu erstellen und im sich öffnen-
den Dialogfenster die gewünschten Einstellungen für jeden Rahmen vornehmen. Wie bei den an-
deren Vorlagen auch ist aber der Weg über das Formatvorlagenfenster und die Zuweisung zu ei-
ner bereits erstellten Rahmenvorlage die einfachste und effektivste Methode die Rahmen zu for-
matieren.
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Standard-Rahmenformatvorlagen
Wenn Sie mehrere Grafiken in Ihr Dokument einbinden möchten, können Sie verschiedene Rah-
menvorlagen definieren: mit unterschiedlichen Rahmenbegrenzung oder Farbhintergründen sowie 
eine weitere Rahmenvorlage nur für den Text.

Andererseits stellt Ihnen Writer, die in Tabelle 1 aufgelisteten, vordefinierten Rahmenvorlagen zur 
Verfügung, die für eine Vielzahl von Aufgaben ausreichend sind. Oftmals reicht es, den Rahmen zu
gestalten oder bei oftmaliger Verwendung aus den vordefinierten Rahmenvorlagen eigene zu er-
stellen.

Tabelle 1. Rahmenvorlagen und ihre Verwendung

Rahmenvorlage Verwendung und Kommentar

Etiketten Die Rahmenvorlage wird von LibreOffice für Etiketten (Menü: Datei > Neu > 
Etiketten) verwendet und ist nicht zur Verwendung durch den Benutzer ge-
dacht. Der Inhalt, die Position und Größe des Rahmens sind geschützt. Die 
Verankerung erfolgt ''Am Zeichen''.

Formel Die Rahmenvorlage wird für Formeln verwendet. Der Rahmen wird horizontal 
links ausgerichtet und am Zeichen verankert.

Grafik Die Rahmenvorlage wird vorzugsweise für Grafiken verwendet. Der Rahmen 
wird horizontal mittig ausgerichtet und am Absatz verankert. Zwischen dem 
Inhalt und der Umrandung ist kein Abstand festgelegt.

Marginalie Rahmenvorlage für Marginalien. Der Rahmen ist für Kommentare, Korrektu-
ren oder Bemerkungen auf dem Rand vorgesehen. Der Rahmen wird links, 
am Anfang des Absatzes platziert und am Absatz verankert. Zwischen dem In-
halt und der Umrandung ist kein Abstand festgelegt.

OLE Rahmenvorlage für OLE-Objekte. Der Rahmen wird horizontal zentriert und 
vertikal nach oben ausgerichtet. Die Verankerung erfolgt ''Am Absatz''. Zwi-
schen Inhalt und Umrandung ist kein Abstand festgelegt.

Rahmen Das ist die Standard-Rahmenvorlage. Der Rahmen wird horizontal mittig aus-
gerichtet und am Absatz verankert. Zwischen dem Inhalt und der Umrandung 
ist ein Abstand festgelegt und der Rahmen wird durch eine Umrandung be-
grenzt.

Wasserzeichen Die Rahmenvorlage für Wasserzeichen, z. B. für ein Hintergrundbild oder ei-
nen Text. Das Wasserzeichen sollte schwach, aber noch lesbar sein und in 
der Anordnung unter dem eigentlichen, gut lesbaren Text liegen. Der Rahmen 
wird horizontal und vertikal mittig ausgerichtet und an der Seite verankert. 

Standardmäßig verwenden alle Rahmenvorlagen die Absatzvorlage Rahmeninhalt und die Zei-
chenvorlage Standard. Die Eigenschaft Automatische Größe ist nur für die Höhe aktiviert, da-
durch passt sich die Größe (Höhe) des Rahmens an die Höhe des Inhalts (Text, Formel, Grafik) 
an. Wird die Formel im Formeleditor geschrieben, wird sowohl die Höhe, als auch die Breite des 
Rahmens an die Formel automatisch angepasst. Sie sollten bei der Erstellung eines Rahmens 
auch für die Breite die Eigenschaft Automatische Größe auf aktiviert setzen.

Eine neue Rahmenvorlage erstellen
Analog der bereits beschriebenen Vorgehensweise zur Erstellung von Formatvorlagen, können Sie
auch Rahmenvorlagen erzeugen:

• Öffnen Sie das Fenster Formatvorlagen (über die Funktionstaste F11, das Menü Format > 
Formatvorlagen oder das Symbol  oder ).
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• Wählen Sie die Rahmenvorlagen und daraus eine Vorlage, die als Grundlage für Ihre neue 
Rahmenvorlage dienen soll, z. B. Mein Rahmen. Mit der rechten Maustaste öffnen Sie das 
Kontextmenü und wählen Neu.

• Im sich öffnenden Dialogfenster Rahmenvorlage können Sie auf den einzelnen Seiten Än-
derungen an den Einstellungen vornehmen und die Rahmenvorlage Ihren Bedürfnissen an-
passen. Achten Sie darauf, dass die Vorgaben nicht zu starr sind, damit die Rahmenvorla-
ge auch für ähnliche Objekte verwendbar bleibt.

Verwalten
Auf der Seite Verwalten (Abbildung 28) können Sie allgemeine Angaben zur neu erstellten Rah-
menvorlage machen.

Abbildung 28: Die Rahmenvorlage, Seite Verwaltung.

• Name: Geben Sie der Formatvorlage eine aussagekräftige Bezeichnung, die beispielswei-
se die Verwendung beschreibt, wie etwa Rahmen, breiter Rand.

• Automatisch aktualisieren (Standard: Nicht aktiviert): Bei aktivierter Option werden Ände-
rungen durch direkte Formatierung in die entsprechende Formatvorlage geschrieben und 
alle übrigen Rahmen im Dokument, die ebenfalls auf dieser Formatvorlage beruhen, wer-
den automatisch angepasst.

Achtung Wenn Sie gewöhnlich die direkte (manuelle) Formatierung verwenden, vergewis-
sern Sie sich, dass die Option Automatisch aktualisieren nicht aktiviert ist, an-
dernfalls können Teile des Dokuments unerwartet neu formatiert sein.

• Verknüpft mit: Beim Erstellen einer neuen Formatvorlage:

◦ wird die neue Formatvorlage mit der Formatvorlage verknüpft, die Sie über Rechts-
klick ausgewählt haben, um diese neue Formatvorlage zu erstellen.

◦ wird der Name der über Rechtsklick ausgewählten Formatvorlage in das Feld Ver-
knüpft mit eingetragen.

◦ werden die Eigenschaften der über Rechtsklick ausgewählten Formatvorlage in die 
neue Formatvorlage übernommen.

• Bereich: Hier legen Sie fest, in welchem Bereich die Formatvorlage sichtbar ist. Für selbst-
erstellte Vorlagen bietet sich der Bereich Benutzervorlagen an. Den Bereich können Sie im 
Formatvorlagenfenster unterhalb der Vorlage filtern.

• Enthält: Zeigt eine Zusammenfassung der Eigenschaften der Formatvorlage.
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Typ
Über die Seite Typ (Abbildung 29) bestimmen Sie die Größe und die Position des Rahmens auf 
der Seite. Im Vorschaufeld (rechts oben) sehen Sie, wie sich die Einstellungen auswirken.

Abbildung 29: Die Rahmenvorlage, Seite Typ.

Bereich Größe:

• Breite (Standard: 0,34 cm): Breite des Rahmens. Wenn die Option Automatisch ausge-
wählt ist, ist der angegebene Wert die Mindestbreite des Rahmens. Sie sollten für die Brei-
te einen größeren Wert zuweisen oder auch die Option Automatisch aktivieren.

• Relativ zu (Standard: Nicht aktiviert): Berechnet die Breite des Rahmens in Prozent an-
hand der Breite der Seite mit Rand (Relativ zu: Absatzbereich) oder ohne Rand (Relativ 
zu: Gesamte Seite).

• Automatisch (Standard: Nicht aktiviert): Passt die Breite des Rahmens automatisch an 
den Inhalt an.

• Höhe (mindestens) (Standard: 0,34 cm): Höhe des Rahmens. Wenn die Option Automa-
tisch ausgewählt ist, ist der angegebene Wert die Mindesthöhe des Rahmens.

• Relativ zu (Standard: Nicht aktiviert): Berechnet die Höhe des Rahmens in Prozent an-
hand der Hohe der Seite mit Rand (Relativ zu: Absatzbereich) oder ohne Rand (Relativ 
zu: Gesamte Seite).

• Automatisch (Standard: Aktiviert): Passt die Höhe des Rahmens automatisch an den In-
halt an.

• Seitenverhältnis beibehalten (Standard: Nicht aktiviert): Behält das Verhältnis von Höhe 
und Breite bei, wenn Sie eine der beiden Größen ändern.

Bereich Position:

• Horizontal (Standard: Mitte): Richtet den Rahmen horizontal auf der Seite aus. Diese Opti-
on ist nicht verfügbar, wenn für die Verankerung des Rahmens "Als Zeichen" gewählt wur-
de.

• um (Standard: 0,00 cm): Das Feld ist nur verfügbar, wenn im Feld Horizontal die Auswahl 
"Von Links" getroffen wurde. Der Wert gibt den horizontalen Abstand zwischen dem linken 
Rand des Rahmens und den im Feld Zu ausgewählten Bezugspunkt an.

• zu (Standard: Absatztextbereich): Bezugspunkt für die horizontale Ausrichtung des Rah-
mens.
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• Auf geraden Seiten spiegeln (Standard: Nicht aktiviert): Spiegelt die aktuellen Einstellun-
gen für die horizontale Ausrichtung auf geraden Seiten.

• Vertikal (Standard: Oben): Richtet den Rahmen vertikal auf der Seite aus. Diese Option ist 
nicht verfügbar, wenn für die Verankerung des Rahmens "Als Zeichen" gewählt wurde.

• um (Standard: 0,00 cm): Das Feld ist nur verfügbar, wenn im Feld Vertikal die Auswahl 
"Von Oben" oder bei einer Verankerung "Als Zeichen" die Auswahl "Von Unten" getroffen 
wurde. Der Wert gibt den vertikalen Abstand zwischen dem oberen Rand des Rahmens 
und den im Feld Zu ausgewählten Bezugspunkt an.

• zu (Standard: Absatztextbereich): Bezugspunkt für die vertikale Ausrichtung des Rahmens.

• Textfluss folgen (Standard: Nicht aktiviert): Der Rahmen wird innerhalb der Layout-Gren-
zen des Textes gehalten, mit dem es verankert ist. Möchten Sie den Rahmen beliebig im 
Text positionieren, so darf diese Option nicht aktiviert sein.
Die Option Textfluss folgen ist standardmäßig aktiviert, wenn Sie ein Dokument öffnen, 
das mit einer Version von Writer älter als OpenOffice 2.0 erstellt wurde. Diese Option ist je-
doch nicht beim Erstellen bzw. Öffnen von Dokumenten im Microsoft Word-Format (*.doc) 
aktiviert.

Optionen
Auf der Seite Optionen (Abbildung 30) nehmen Sie Einstellungen zum Schutz des ausgewählten 
Rahmens und dessen Inhalt fest. 

Abbildung 30: Die Rahmenvorlage, Seite Optionen.

Bereich Schützen: Legt die Schutzoptionen für den Rahmen fest.

• Inhalt (Standard: Nicht aktiviert): Der Inhalt des Rahmens wird vor Änderungen geschützt. 
Der Inhalt kann noch kopiert werden.

• Position (Standard: Nicht aktiviert): Die Position des Rahmens wird vor Änderungen ge-
schützt.

• Größe (Standard: Nicht aktiviert): Schützt die Größe des gewählten Objekts vor Änderun-
gen.

Bereich Eigenschaften: In diesem Bereich finden Sie die Optionen, die den Rahmen vor ungewoll-
ten Veränderungen schützen.

• Editierbar in schreibgeschütztem Dokument (Standard: Nicht aktiviert): Erlaubt das Be-
arbeiten des Inhalts eines Rahmens auch dann, wenn das Dokument schreibgeschützt ist.

• Drucken (Standard: Aktiviert): Druckt den Rahmen mit aus.

• Textfluss: (Standard: Einstellung des übergeordneten Objektes verwenden): Legt die 
Schreibrichtung innerhalb des Rahmens fest. Bei Auswahl von Einstellung des überge-
ordneten Objektes verwenden wird die Standardschreibrichtung der Seite verwendet.

Bereich Inhaltsausrichtung:
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• Vertikale Ausrichtung (Standard: Oben): Legt die vertikale Ausrichtung des Rahmenin-
halts fest. Diese Einstellung wirken sich neben dem Textinhalt auch auf andere Objekte 
aus, die am Textbereich verankert sind (verankert “Als Zeichen“, “Am Zeichen“ oder “Am 
Absatz“), wie z. B. Tabellen, Grafiken oder Zeichnungen.

Umlauf
Die Eigenschaften, die Sie auf der Seite Umlauf (Abbildung 31) festlegen können, beeinflussen 
maßgeblich das Aussehen (Layout) Ihres Dokuments, besonders des Textes zum eingebetteten 
Rahmen.

Abbildung 31: Die Rahmenvorlage, Seite Umlauf.

Sie stellen hier den Abstand zwischen Rahmen und den Text innerhalb der Rahmenbegrenzung 
ein sowie den Umlauf des Textes um den Rahmen.

Im Bereich Einstellungen wird festgelegt, wie der Text um einen eingebetteten Rahmen läuft. Klei-
ne Icons zeigen Textverlauf und Rahmen an:

• Kein: Platziert den Rahmen in einer eigenen Zeile im Dokument. Der Text im Dokument er-
scheint über und unter dem Rahmen, nicht jedoch zu seinen Seiten. Mit zunehmender 
Rahmenhöhe wird der Text weiter auseinander geschoben. 

• Vor: Ist zwischen dem linken Textrand und dem Rahmen genügend Platz vorhanden, um-
läuft der Text den Rahmen auf der linken Seite.

• Hinter: Ist zwischen dem rechten Textrand und dem Rahmen genügend Platz vorhanden, 
umläuft der Text den Rahmen auf der rechten Seite.

• Parallel (Standard): Lässt den Text um den Rahmen herum laufen.

• Durchlauf: Stellt den Rahmen vor den Text. Je nach Einstellungen des Hintergrundes (s. 
Seite Hintergrund, S. 38), verdeckt der Rahmen den Text oder der Rahmen und dessen 
Inhalt ist mehr oder weniger transparent und der Text scheint durch den Rahmen hindurch.

• Optimal: Der Textumlauf erfolgt automatisch um den Rahmen. Beträgt der Abstand zwi-
schen Rahmen und Seitenrand weniger als 2 cm beträgt, wird der Textumlauf unterbunden.

Tipp
Um einen Text um eine Tabelle laufen zu lassen, setzen Sie die Tabelle in einen 
Rahmen und lassen dann den Text um den Rahmen laufen.

Der Abstand zwischen der Rahmenbegrenzung und Objekten innerhalb des Rahmens (Text, Bilder,
Grafiken, Draw-Zeichnungen u. a.) wird im Bereich Abstand festgelegt:
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• Links (Standard: 0,20 cm): Abstand zwischen dem linken Rahmenrand und dem Text.

• Rechts (Standard: 0,20 cm): Abstand zwischen dem rechten Rahmenrand und dem Text.

• Oben (Standard: 0,20 cm): Abstand zwischen dem oberen Rahmenrand und dem Text.

• Unten (Standard: 0,20 cm): Abstand zwischen dem unteren Rahmenrand und dem Text.

Zum Textumlauf können im Bereich Optionen zusätzliche Festlegungen getroffen werden:

• Erster Absatz (Standard: Nicht aktiviert): Beim Verschieben des Rahmens aus dem Absatz
heraus, wird der Text des nächsten Absatzes nicht mehr umflossen. Der nächste Absatz 
wird immer unter dem Rahmen begonnen.

• Im Hintergrund (nur für die Umlaufart Durchlauf verfügbar; Standard: Nicht aktiviert): Legt 
den Rahmen in den Hintergrund (hinter den Text). Der Rahmen scheint durch den Text 
durch. Das ist z. B. für Grafiken innerhalb eines Rahmens eine Formatierungsmöglichkeit.

• Kontur (nur für die Umlaufarten Vor, Hinter, Parallel und Optimal verfügbar; Standard: 
Nicht aktiviert): Lässt den Text um die Objektform laufen. Diese Option ist für die Umlaufart 
Durchlauf wie auch für Rahmen nicht verfügbar. Um die Kontur eines Objekts zu ändern, 
wählen Sie das Objekt aus und wählen dann Format - Umlauf - Kontur bearbeiten. 

• Nur außen (nur verfügbar, wenn die Option Kontur (für die Umlaufarten Vor, Hinter, Paral-
lel und Optimal verfügbar) ausgewählt wurde; Standard: Nicht aktiviert): Lässt den Text nur 
um die Objektkonturen, nicht jedoch in offene Bereichen innerhalb der Objektform laufen. 
Diese Option ist nicht für Rahmen verfügbar.

Hintergrund
Analog der Hintergrund in den Absatzvorlagen (S. 24) lässt sich für Rahmenvorlagen eine Hinter-
grundfarbe oder eine Grafik wählen. Der einzige Unterschied ist, dass der Transparenzgrad einge-
stellt werden kann:

• Transparenz (Standard: 0 %): Stellen Sie die Transparenz in % ein, um den Rahmeninhalt 
für Text durchsichtig zu machen.

Umrandung
Auch hier wird auf die Ausführungen zu den Absatzvorlagen, Umrandung (S. 25) verwiesen. Die 
Option Mit dem nächsten Abschnitt verschmelzen ist jedoch nicht vorhanden.

Spalten
Die Seite Spalten (Abbildung 32) wird verwendet, um Text innerhalb eines Rahmens spaltenförmig
zu formatieren. Sie legen hier Spaltenanzahl und deren Breite fest. Die Seite ist in die drei Berei-
che Vorgaben, Breite und Abstand sowie Trennlinie unterteilt.
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Abbildung 32: Die Rahmenvorlage, Seite Spalten.

Standardmäßig wird ein einspaltiger Text vorgegeben. Erst mit der Erhöhung der Spaltenanzahl 
sind weitere Felder für eine Änderung verfügbar. Sind die Vorgaben besonders hinsichtlich des 
Spaltenabstandes nicht ausreichend, deaktivieren Sie das Kontrollkästchen “Automatische Brei-
te“ und ändern die Werte. Auch eine genaue Positionierung der Trennlinie zwischen zwei Spalten 
ist möglich. Das Vorschaufeld rechts oben zeigt nur die Spalten, nicht die Seite an und gibt eine 
Voransicht zu den gewählten oder geänderten Einstellungen.

Im Bereich Vorgaben wird die Spaltenanzahl festgelegt:

• Spalten (Standard: 1): Geben Sie die gewünschte Spaltenanzahl für den Rahmen ein. Die 
Spalten werden gleichmäßig über die Rahmenbreite verteilt. Außerdem können Sie auch 
rechts neben dem Eingabefeld für die Spaltenzahl eines der vordefinieren Spaltenlayouts 
auswählen.

Die beiden anderen Bereiche dienen der Formatierung der Spalten. Der Bereich Breite und Ab-
stand erlaubt die Einstellung der Breite der Spalten und deren Abstände:

• Spalte: Zeigt die Spaltennummer an. Wenn im Feld Spalten mehr Spalten eingestellt sind, 
als als im Dialogfenster darstellbar ist, werden ein linker und ein rechter Pfeil zugänglich, 
die die Spaltenanzeige eine Spalte nach links oder rechts bewegen.

• Breite: Wenn das Kontrollkästchen “Automatische Breite“ nicht aktiviert ist, können Sie 
die Breite der Spalte ändern.

• Abstand: Geben Sie den gewünschten Abstand zwischen den Spalten ein.
Wenn das Kontrollkästchen “Automatische Breite“ aktiviert ist, lässt sich nur das linke 
Feld ändern: Der Abstand zwischen den Spalten wird einheitlich eingestellt.
Wenn das Kontrollkästchen “Automatische Breite“ nicht aktiviert ist, lässt sich der Ab-
stand zwischen allen eingestellten Spalten ändern: Im linken Feld zwischen den Spalten 1 
und 2 und im rechten Feld zwischen den Spalten 2 und 3.

• Automatische Breite (Standard: Aktiviert): Den Spalten werden die gleiche Breite zuge-
ordnet. Sollen die Spalten verschiedene Breiten haben, deaktivieren Sie dieses Kontroll-
kästchen.

Über den Bereich Trennlinie , der nur verfügbar ist, wenn zwei oder mehr Spalten im Feld Spalten 
ausgewählt wurden, lässt sich das Layout der Spalten weiter verfeinern:

• Stil (Standard: kein): Legt die Linienart der Spaltentrennlinie fest. Erst wenn Sie eine ande-
re Linienart wählen, sind die anderen Einstellmöglichkeiten zugänglich.

• Höhe (Standard: 100 %): Länge der Trennlinie in Prozent der Spaltenhöhe.
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• Farbe (Standard: Schwarz): Farbe der Spaltentrennlinie.

• Breite (Standard: 0,25 pt): Breite der Spaltentrennlinie in pt. Sie können die Breite auch in 
einer anderen Maßeinheit angeben.

• Position (Standard: Oben): Die vertikale Ausrichtung der Trennlinie. Das Feld ist nur ver-
fügbar, wenn das Feld Höhe kleiner als 100% ist.

Makro
Legt das Makro fest, dass beim Klicken auf einen Rahmen ausgeführt werden soll. Makros sind für
Rahmen nur in Online- oder HTML-Dokumenten sinnvoll einsetzbar. Zur Makro-Programmierung 
finden Sie weiter Anwendungsmöglichkeiten in folgenden LibreOffice Dokumentationen:

• Handbuch ''Erster Schritte'', Kapitel 13 – Einführung in Makros.

• 'Kurzanleitungen ''Makroprogrammierung''.

Seitenvorlagen

LibreOffice verwendet Seitenvorlagen, um die Seitengröße, die Ausrichtung von Seiten, Ränder, 
Kopf- und Fußzeilen und weitere Eigenschaften der Seite zu definiert. Im Gegensatz zu Absätzen 
oder Zeichen, deren Eigenschaften auch direkt über die Symbolleiste einstellbar sind, lassen sich 
die Seiteneigenschaften nur über die Seitenvorlagen ändern. Auch bei der Anpassung über das 
Menü Format > Seite wird die Seitenvorlage selbst geändert. In diesem Abschnitt wird beschrie-
ben, wie neue Seitenvorlagen erstellt werden und welche Auswirkungen die Einstellungen auf den 
verschiedenen Seiten der Formatvorlage haben.

Eine neue Seitenvorlage erstellen
Um eine neue Seitenvorlage zu erstellen, öffnen Sie das Formatvorlagenfenster (über die Funkti-
onstaste F11, das Menü Format > Formatvorlagen oder das Symbol  oder  in der Symbol-
leiste Format zu erreichen) und klicken auf das Symbol  um die Seitenvorlagen anzuzeigen. Mit ei-
nem Rechtsklick auf eine vorhandene Seitenvorlage oder in den leeren Bereich des Fensters öff-
net sich ein Kontextmenü: Der Menüpunkt Neu öffnet ein Dialogfenster zur Bearbeitung der Sei-
tenvorlage (Abbildung 33). Über acht Seiten lassen sich die Eigenschaften für die Seitenvorlagen 
einstellen.

Verwalten
Diese Seite wurde bereits in “Die Seite Verwalten” auf Seite 6 beschrieben. Ein Beispiel soll das 
Arbeiten mit Seitenvorlagen, insbesondere mit der Folgevorlage demonstrieren.

Sie möchten ein Dokument erstellen, das eine Titelseite hat, die sich von den eigentlichen Seiten 
des Dokuments unterscheidet. Die nachfolgenden Seiten sollen wie bei einem Buch einen linke 
und eine rechte Seite haben.

• Titelseite soll:

◦ keine Kopfzeile haben,

◦ keine Seitennummer haben,

◦ linke und rechte Rand sollen gleich sein.

• Dokumentenseite:

◦ linke und rechte Seiten sollen sich abwechseln,

◦ nach der Titelseite wird mit einer rechten Seite angefangen.
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Sie können die in LibreOffice Writer vordefinierte Seitenvorlage Erste Seite für die Titelseite und 
Linke Seite und Rechte Seite für die Dokumentenseiten verwenden.

Wählen Sie in der Seitenvorlage Ersten Seite im Feld Folgevorlage den Eintrag Rechte Seite.

Wählen Sie in der Seitenvorlage Rechte Seite im Feld Folgevorlage den Eintrag Linke Seite.

Wählen Sie in der Seitenvorlage Linke Seite im Feld Folgevorlage den Eintrag Rechte Seite.

Falls gewünscht sind in den Seitenvorlagen Linke Seite und Rechte Seite noch die Kopf- bzw. 
Fußzeilen zu aktivieren und die Seitenzahlen einzusetzen. Weitere Erläuterungen werden in den 
weiteren Abschnitten gegeben.

Seitenformat und Ränder
Im Reiter Seite werden Angaben zum Seitenformat, zu den Seitenrändern (typografisch: Stege) 
und weiteren Layouteinstellungen gemacht. Neben den Bereichen ist rechts oben eine Vorschau 
zu den Änderungen an der Seite zu sehen (Abbildung 33).

Angaben zum Seitenformat sind im Bereich Papierformat vorzunehmen:

• Format (Standard: A4): Aus einer Auswahlliste lässt sich eine Papiergröße auswählen. Ein 
benutzerdefiniertes Papierformat erstellen Sie, indem Sie die Seitenabmessungen in die 
unterhalb liegenden Felder Höhe und Breite eingeben.

• Breite (Standard: aus der Auswahl im Feld Format abgeleitet): Breite des ausgewählten 
Papierformats. Für ein benutzerdefiniertes Format geben Sie hier die Breite ein.

• Höhe (Standard: aus der Auswahl im Feld Format abgeleitet): Höhe des ausgewählten Pa-
pierformats. Für ein benutzerdefiniertes Format geben Sie hier die Höhe ein.

• Ausrichtung (Standard: Hochformat): Wählen Sie zwischen Hochformat und Querformat. 
Die Änderung der Ausrichtung wirkt sich auf alle Seiten, die mit der Formatvorlage erstellt 
wurden aus. Um in einem Dokument zwischen Hoch- und Querformat zu wechseln, ver-
wenden Sie den Menüpfad Einfügen > Manueller Umbruch …, Option Seitenumbruch 
und die Vorlage Querformat bzw. Standard, um zum Hochformat zurückzukehren.

• Papierschacht: Papierzufuhr für Drucker mit mehreren Papierschächten. Es besteht auch 
die Möglichkeit, jeder Seitenvorlage eine andere Papierzufuhr zuzuweisen. Beispielsweise 
können Sie der ersten Seitenvorlage eines Schreibens einen anderen Papierschacht zu-
weisen und das Papier mit dem Briefkopf Ihrer Firma in diesen Schacht laden.

Der Abstand zwischen dem Papierrand und dem Dokumententext (einschließlich Kopf- und Fuß-
zeile) wird im Bereich Seitenränder festgelegt:

• Links / Innen (Standard: 2 cm): Abstand zwischen dem linken Seitenrand und dem Doku-
menttext. Beim Seitenlayout Gespiegelt ist das der Abstand zwischen innerem Text- und 
innerem Seitenrand.

• Rechts / Außen (Standard: 2 cm): Abstand zwischen dem rechten Seitenrand und dem 
Dokumenttext. Beim Seitenlayout Gespiegelt ist das der Abstand zwischen äußeren Text- 
und äußerem Seitenrand.

• Oben (Standard: 2 cm): Abstand zwischen dem oberen Seitenrand und dem Dokument-
text.

• Unten (Standard: 2 cm): Abstand zwischen dem unteren Seitenrand und dem Dokument-
text.
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Abbildung 33: Die Seitenvorlage, Allgemeine Formateinstellungen für die Seite.

Allgemein werden für das Seitenlayout asymmetrische Seitenränder verwendet, sowohl für die lin-
ken und rechten als auch für die oberen und unteren Begrenzungen. Dadurch hat der Leser mehr 
Platz, um das Buch oder das Dokument zu halten.

Es gibt zwei Grundregeln für das Layout gedruckter Seiten:

a) Der äußere Rand (rechter Rand einer rechten Seite) ist größer als der innere Rand (linker 
Rand einer rechten Seite).

b) Der untere Rand ist größer als der obere Rand.

Auf ihrer Webseite zum Desktop Publishing von About.com werden dazu weitere Hinweise zum 
Seitenlayout gegeben.

Auch in Writer lassen sich im Bereich Layouteinstellungen Einstellungen zum Seitenlayout vorneh-
men:

• Seitenlayout (Standard: Rechts und Links): Aus einer Auswahlliste bestimmen Sie das 
Seitenlayout für das aktuelle Dokument:

◦ Rechts und Links (Standard): Die Seitenvorlage zeigt gerade und ungerade Seiten 
mit linken und rechten Seitenrändern an, wie im Bereich Seitenränder angegeben.

◦ Gespiegelt: Die Seitenvorlage zeigt gerade und ungerade Seiten mit inneren und äu-
ßeren Seitenrändern an, wie im Bereich Seitenränder angegeben . Verwenden Sie 
dieses Layout, wenn Sie die gedruckten Seiten wie ein Buch binden möchten. Geben 
Sie den Bundsteg als inneren Seitenrand ein.

◦ Nur Rechts: Die Seitenvorlage zeigt nur ungerade (rechte) Seiten an. Gerade Seiten 
werden als leere Seiten angezeigt.
Wenn die erste Seite eines neuen Kapitels auf der rechten Seite beginnen soll, setzen
Sie das Seitenlayout auf Nur Rechts. Für die folgenden Seiten wählen Sie den Ein-
trag Gespiegelt. Die Kopf- und Fußzeilen dieser gespiegelten Seiten müssen nicht 
gleich sein.

◦ Nur Links: Die aktuelle Seitenvorlage zeigt nur gerade (linke) Seiten an. Ungerade 
Seiten werden als leere Seiten angezeigt.

• Format: Das Nummerierungsformat für die Seitenvorlage, z. B. für die Seitennummern.

• Registerhaltigkeit: Richtet den Text mit der ausgewählten Seitenvorlage an einem vertika-
len Seitenraster aus. Der Abstand des Rasters wird durch die Referenzabsatzvorlage be-
stimmt. Beachten Sie dazu auch die Ausführungen zur Registerhaltigkeit auf S. 11.
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• Referenzabsatzvorlage: Absatzvorlage, die als Referenz für die Textanordnung in der aus-
gewählten Seitenvorlage dienen soll. Die Höhe der in der Referenz-Formatvorlage angege-
bene Schrift bestimmt den Abstand des vertikalen Seitenrasters.

Für linke und rechte Seiten lassen sich jeweils eigene Seitenvorlagen definieren. Damit lassen sich
die Seiten sehr verschieden gestalten, wie z. B. durch:

• unterschiedliche Seitenränder,

• Kopf- und Fußzeilen, wahlweise nur auf einer Seite,

• Darstellung von Grafiken oder Fotos nur auf einer Seite und Texte auf der anderen Seite.

In diesem Fall setzen Sie für die zuerst verwendete Seitenvorlage auf der Seite Verwalten das 
Feld Folgevorlage auf Linke Seite und das Seitenlayout auf Nur Links. Die nächste Seite ist 
dann die Seitenvorlage Linke Seite, in deren Feld Folgevorlage (auf der Seite Verwalten) Rech-
te Seite auszuwählen ist. Das zugeordnete Seitenlayout wird auf Nur Rechts gesetzt.

In diesem Fall ordnen Sie der ersten Seite die vordefinierte Seitenvorlage Erste Seite zu. In dieser
Seitenvorlage setzen Sie auf der Seite Verwalten das Feld Folgevorlage auf Linke Seite. In die-
ser Seitenvorlage steht bereits die Folgevorlage auf Rechte Seite und das Seitenlayout auf Nur 
Links. Die nächste Seite ist dann die Seitenvorlage Rechte Seite, in deren Feld Folgevorlage 
(auf der Seite Verwalten) Linke Seite steht und das zugeordnete Seitenlayout auf Nur Rechts ge-
setzt ist.

Am Beginn eines Kapitels steht demnach zuerst eine Erste Seite, dann eine Linke Seite, eine 
Rechte Seite, eine Linke Seite, eine Rechte Seite usw.

Hintergrund
Analog dem Hintergrund in den Absatzvorlagen (S. 24) lässt sich für die Seitenvorlage eine Hin-
tergrundfarbe oder eine Grafik wählen. Beachten Sie, dass Hintergrund und Grafik nur den Bereich
innerhalb der Ränder ausfüllen. Soll auch der Bereich außerhalb der Ränder mit einer Hintergrund-
farbe belegt werden, so wird das über das Menü Extras > Tools > LibreOffice > Darstellung 
durch Änderung des Dokumenthintergrundes realisiert.

Kopfzeile und Fußzeile
Diese Seite legen die Eigenschaften für die Kopfzeile bzw. Fußzeile fest. Da Kopf- und Fußzeilen 
die gleichen Einstellmöglichkeiten bieten, werden sie in einem Abschnitt behandelt.

Für jede Seitenvorlage lassen sich unterschiedliche Kopf- und Fußzeilen vorgeben, so dass das 
Aussehen von linken und rechten Seiten anders gestaltet werden kann. Die erste Seite eines Kapi-
tels enthält dann beispielsweise keine Kopfzeile. Das können Sie erreichen, indem Sie für die er-
stellte Seitenvorlage festlegen, ob die erste Seite auch, wie die Folgeseiten, eine Kopf-/Fußzeile 
haben soll.

Das Einrichten einer Kopf- oder Fußzeile ist relativ einfach (Abbildung 34).
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Abbildung 34: Die Seitenvorlage, Seite Kopfzeile.

Zuerst aktivieren Sie das standardmäßig ausgeschaltete Kontrollkästchen Kopfzeile einschalten. 
Dadurch wird eine Kopfzeile in die aktuelle Seitenvorlage eingefügt. Kopfzeilen sind Bereiche in-
nerhalb des oberen Seitenrands, in die sich Text oder Grafiken einfügen lassen, die auch mit Um-
randungen oder Hintergrundfüllungen versehen werden können. Die Breite der Kopf-/Fußzeilen 
entspricht der Breite des Dokumententextes. Soll die Breite größer sein, also in den Seitenrand 
hineinragen, müssen Sie einen Rahmen mit der entsprechenden Breite in die Kopfzeile einfügen.

Mit eingefügter Kopfzeile werden weitere Optionen zugänglich:

• Inhalt links/rechts gleich (Standard: Aktiviert): Auf geraden und ungeraden Seiten wird 
die gleiche Kopfzeile eingefügt. Bei nicht aktivierter Option, können für linke und rechte 
Seiten jeweils eigene Kopfzeile definiert werden (Abbildung 35).

Abbildung 35: Verschiedene Kopfzeilen für linke und rechte Seiten.

• Gleicher Inhalt auf der ersten Seite (Standard: Aktiviert): Alle geraden und ungeraden 
Seiten sowie auch die erste Seite erhalten die gleiche Kopfzeile. Bei nicht aktivierter Opti-
on, kann für die erste Seite keine oder eine eigene Kopfzeile erstellt werden. Diese Option 
ist nicht für die Seitenvorlagen Linke Seite und Rechte Seite sowie für Seitenvorlagen ver-
fügbar, die nur eine Seite definieren.

• Linker Rand (Standard: 0): Der Abstand zwischen dem linken Seitenrand und dem linken 
Rand der Kopfzeile.

• Rechter Rand (Standard: 0): Der Abstand zwischen dem rechten Seitenrand und dem 
rechten Rand der Kopfzeile.

• Abstand (Standard: 0,50 cm): Abstand zwischen dem unteren Rand der Kopfzeile und 
dem oberen Rand des Textes.
Für Fußzeilen: Abstand zwischen dem oberen Rand der Fußzeile und dem unteren Rand 
des Textes.

• Dynamischen Abstand verwenden (Standard: Nicht aktiviert): Bei einzeiliger Kopfzeile 
wird der im Feld Abstand angegebene Wert eingehalten. Ist die Kopfzeile mehrzeilig, wird 
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der Abstand zum Text mit jeder Zeile verkürzt. Bei dem eingestellten Standardabstand von 
0,5 cm ist bereits die 2. Zeile bis an den Dokumententext herangerückt.

• Höhe (Standard: 0,50 cm): Höhe der Kopfzeile.
Für Fußzeilen: Höhe der Fußzeile.

• Höhe dynamische anpassen (Standard: Aktiviert): Die Höhe der Kopfzeile wird automa-
tisch an den Inhalt der Kopfzeile angepasst. Bei nicht aktivierter Option  wird der Kopfzei-
lentext nur für eine Zeile angezeigt, sofern die Standardeinstellungen aktiviert sind. Weitere
Zeilen sind nicht mehr sichtbar.

• Mehr: Über die Schaltfläche Mehr können Sie eine Umrandung oder einen anderen Hinter-
grund für die Kopfzeile festlegen. Da die Einstellmöglichkeiten zu Umrandungen und Hin-
tergründen denen der Absatzvorlage entsprechen, wird an dieser Stelle auf die Abschnitte 
der Absatzvorlage Hintergrund, S. 24 und Umrandung, S. 25 verwiesen.

Tipp
Um den Cursor schnell vom Dokumenttext in die Kopf- oder Fußzeile zu setzen, 
drücken Sie Strg+BildAuf bzw. Strg+BildAb. Mit der gleichen Tastenkombination 
positionieren Sie den Cursor wieder in den Dokumenttext.

Spalten
Die Seite Spalten entspricht der gleichnamigen Seite in den Rahmenvorlagen. Deshalb wird zur 
Erklärung zu den Einstellmöglichkeiten auf den Abschnitt Spalten auf Seite 38 verwiesen.

Fußnote
Eine Fußnote ist eine Anmerkung, Legende, Bemerkung, Quellenangabe oder weiterführende Er-
klärung zu einem Text, die im Druck-Layout aus dem Fließtext ausgelagert wird, um den Text flüs-
sig lesbar zu gestalten. Auf dieser Seite legen Sie den Fußnotenbereich einschließlich der Trennli-
nie zwischen der Fußnote und dem Dokumententext fest (Abbildung 36).

Im Fußnotenbereich legen Sie die Höhe und Breite der Fußnote fest:

• Höhe maximal wie Seite:(Standard: Aktiviert): Die Höhe des Fußnotenbereichs wird auto-
matisch an die Anzahl der Fußnoten angepasst.

• Maximale Höhe der Fußnote: (Standard: Deaktiviert, wenn aktiviert 2,00 cm): Maximalhö-
he des Fußnotenbereichs. Aktivieren Sie dieses Feld, wenn Sie die Fußnotenhöhe selbst 
kontrollieren wollen und geben Sie die Höhe des Fußnotenbereichs ein.

• Abstand zum Text: (Standard: 0,10 cm): Abstand zwischen dem unteren Seitenrand und 
der ersten Zeile des Fußnotenbereichs.

Achtung Der Fußnotenbereich wird automatisch an Hand der Anzahl der eingefügten Fuß-
noten berechnet. Wenn Sie den Fußnotenbereich selbst kontrollieren wollen, wäh-
len Sie den Fußnotenbereich nicht größer als die Seitenhöhe.

Der Bereich Trennlinie formatiert die Art, Position, Länge und Farbe der Trennlinie:

• Position (Standard: Links): Horizontale Ausrichtung der Trennlinie zwischen Textkörper 
und Fußnotenbereich.

• Stil (Standard: Durchgehend): Auswahl der Linienart aus der Auswahlliste. Wenn keine 
Trennlinie angezeigt werden soll, wählen Sie Keine ein.

• Dicke (Standard: 0,50 pt): Stärke der Trennlinie.

• Farbe (Standard: Schwarz): Farbe der Trennlinie.

• Länge (Standard: 25 %): Länge der Trennlinie in Prozent zur Seitenbreite.
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• Abstand zum Fußnoteninhalt (Standard: 0,10 cm): Abstand der Trennlinie zur ersten Zei-
le des Fußnotenbereichs.

Abbildung 36: Die Seitenformatvorlage, Seite Fußnote.

Beispiel: Ein Buch - Die ersten Seiten eines Kapitels

In nachfolgendem Beispiel sollen die Seitenvorlagen für ein Buch erstellt werden. Tabelle 2 zeigt 
die gewünschten Layouteigenschaften für die zu verwendenden Seiten, wie sie für ein typisches 
Buch verwendet werden.

Tabelle 2: Eigenschaften der Seitenvorlagen für die Kapitel eines Buches

Seite Formatierung/Eigenschaften Einstellungen der Seitenvorlage

Rechte Seite 
(Erste Seite)

Die erste Seite ist eine Rechte Seite 
mit ungerader Nummerierung

Seite: Seite > Seitenlayout: Nur 
Rechts

Keine Kopf oder Fußzeile Seite: Kopfzeile > Kopfzeile ein-
schalten: Nicht aktiviert

Der obere Rand dieser Seite soll grö-
ßer sein als der der anderen Seiten.

Seite: Seite > Seitenränder > Oben: 
6.00cm

Standard Die Standardseite soll eine gespiegelte
Seite sein (abwechselnd Linke Seite – 
Rechte Seite).

Seite: Seite > Seitenlayout: Gespie-
gelt

Eine Seite mit Kopfzeile: Seiten-Nr. au-
ßen, Kapitelüberschrift mittig.

Seite: Kopfzeile > Kopfzeile ein-
schalten: Aktiviert
Seite: Kopfzeile > Kopfzeile > Inhalt 
links/rechts gleich: Nicht aktiviert

Ein Buchkapitel beginnt normalerweise mit einer rechten Seite. Die erste Seite ist dabei anders ge-
staltet als die Folgeseiten. Bei doppelseitigem Druck sind die Innen- und Außenränder (typogra-
fisch: Bund- und Außenstege) verschieden für die linken und rechten Seiten. Seitenzahlen in Kopf- 
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oder Fußzeilen befinden sich an den jeweiligen Außenrändern der Seiten und der innere Rand ist 
größer, da hier das Buch gebunden werden soll.

Abbildung 37 zeigt die Abfolge der Seiten von der ersten Seite (eine Rechte Seite) zu den gespie-
gelten Standardseiten mit abwechselnden linken und rechten Kopfzeilen, wobei die Seitenzahl mit 
dem Symbol # gekennzeichnet ist.

Rechte
Seite

#

Standard
Seite

#

Standard
Seite

Abbildung 37: Seitenvorlage für ein Buch mit Titelseite und ver-
schiedenen Kopfzeilen für die Standardseiten.

Die Erstellung der Seitenvorlagen erfolgt in fünf Schritten:

Schritt 1: Die Seitenvorlage Rechte Seite (Erste Seite):

1) Im geöffneten Formatvorlagenfenster (über die Funktionstaste F11, das Menü Format > 
Formatvorlagen oder das Symbol  oder  in der Symbolleiste Format zu erreichen) 
wählen Sie das Symbol für die Seitenvorlagen  aus. Es wird die Liste der vorhandenen Sei-
tenvorlagen angezeigt.

2) Ein Rechtsklick auf die Seitenvorlage Rechte Seite öffnet ein Kontextmenü aus dem der 
Eintrag Ändern auszuwählen ist.

3) Auf der Seite Verwalten ändern Sie das Feld Folgevorlage auf Standard (Abbildung 38).

Abbildung 38: Die Seitenvorlage, Seite Verwalten: Ändern der Folgevorlage.

4) Auf der Seite Seite wird ein größerer linker Rand (3,0 cm) als Binderand und ein größerer 
oberer Rand (6,0 cm) eingestellt, um die Kapitelüberschrift etwas tiefer zu setzen. Die wei-
teren Ränder: Rechter Rand: 2,0 cm; unterer Rand: 2,5 cm.

5) Die Kopf- und Fußzeilen dürfen auf den gleichnamigen Seiten nicht eingeschaltet sein.

6) Mit OK speichern Sie die Eintragungen für diese Seitenvorlage.

Schritt 2: Einstellungen der Seitenvorlage Standard:
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1) Nach Rechtsklick auf die Seitenvorlage Standard und Auswahl von Ändern aus dem Kon-
textmenü können Sie die Einstellungen der Seitenvorlage bearbeiten.

2) Auf der Seite Verwalten prüfen Sie, ob im Feld Folgevorlage die Seitenvorlage Standard 
eingetragen ist.

3) Auf der Seite Seite ist unter Seitenlayout Gespiegelt aus der Liste zu wählen (Die Feldna-
me Links und Rechts im Bereich Seitenränder wechseln dann auf Innen und Außen).

4) Auf der Seite Kopfzeile: Aktivieren Sie das Kontrollkästchen Kopfzeile einschalten und 
deaktivieren Sie das Kontrollkästchen Inhalt links/rechts gleich (Abbildung 39).

5) Mit OK speichern Sie die Eintragungen.

Abbildung 39: Die Seitenvorlage, Seite Kopfzeile: Einstellungen für verschiede-
ne Kopfzeilen.

Schritt 3: Einstellungen für die Absatzvorlage Überschrift 1 auf der ersten Seite (Seitenvor-
lage: Rechte Seite):

1) Aus den Absatzvorlagen wählen Sie die Vorlage Überschrift 1 und gehen mit Rechtsklick 
Ändern in den Editiermodus.

2) Auf der Seite Textfluss sind im Bereich Umbrüche die Kontrollkästchen Einfügen und mit 
Seitenvorlage zu aktivieren und im Feld Typ Seite und darunter Rechte Seite auszuwäh-
len (Abbildung 40).

3) Mit OK speichern Sie die Einstellungen.

Abbildung 40: Die Absatzvorlage Überschrift 1, Seite Textfluss.

Schritt 4: Beginn eines neuen Kapitels:

Der erste Absatz, das ist die Kapitelüberschrift, wird mit der Absatzvorlage Überschrift 1 forma-
tiert.

Notiz
Standardmäßig ist die Absatzvorlage Überschrift 1 mit der ersten Gliederungs-
ebene verbunden. Die Zuordnung der Absatzvorlage zu den Gliederungsebenen 
erfolgt über das Menü Extras > Kapitelnummerierung.

Schritt 5: Einstellungen der Kopfzeile:

1) Beim Schreiben des Textes gelangen Sie nach einem Seitenumbruch auf der ersten Seite 
auf eine linke Seite. Mit einem Klick auf die Kopfzeile gelangen Sie in den Bearbeitungsmo-
dus für die Kopfzeile (oder durch die Tastenkombination Strg+Bild auf). Die Änderungen 
werden auf allen Linken Seiten sichtbar sein. Positionieren Sie den Cursor links und fügen 
über das Menü Einfügen > Feldbefehl > Seitennummer eine Seitennummer ein.
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2) Mit der Tab-Taste setzen Sie den Cursor in die Mitte der Kopfzeile und öffnen über die Tas-
tenkombination Strg+F2 oder über das Menü Einfügen > Feldbefehle > Andere ... das 
Dialogfenster Felder (Abbildung 41).

Auf der Seite Dokument wählen Sie im Bereich Typ den Eintrag Kapitel und im Bereich 
Format den Eintrag Kapitelname. Der Wert im Feld Ebene sollte auf 1 stehen.

Abbildung 41: Das Dialogfenster Felder, Seite Dokument.

3) Mit Einfügen übernehmen Sie den Kapitelnamen aus der Überschrift in die Kopfzeile.

4) Auf einer Rechten Seite editieren Sie die Kopfzeile (Klick in die Kopfzeile) und betätigen 
Sie die Tab-Taste, so dass der Cursor in der Mitte der Kopfzeile steht.

5) Fügen Sie einen Querverweis auf die Kapitelüberschrift ein (Dialogfenster Felder, Seite 
Querverweise, Typ: Überschriften, Auswahl: Die entsprechende Überschrift, Referenz: Re-
ferenztext; s. Abbildung 42).
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Abbildung 42: Das Dialogfenster Felder, Seite Querverweise: Einfü-
gen der Kapitelüberschrift in die Kopfzeile.

6) Betätigen Sie noch einmal die Tab-Taste, so dass der Cursor nach rechts in der Kopfzeile 
springt. Geben Sie die Seitennummer ein (Einfügen > Feldbefehl > Seitennummer).

Achtung Wenn Sie die Tabulatorpositionen ändern möchten, dann ändern Sie diese über 
die Absatzvorlage Überschriften. Ändern Sie auf keinen Fall manuell die Positi-
on und die Art der Tabulatoren.

Listenvorlagen

Listenvorlagen werden auch nummerierte Vorlagen genannt. Es lassen sich eine Vielzahl von Lis-
ten definieren: Von einfachen Aufzählungslisten bis zu verschachtelte Listen mit mehreren Ebenen 
(Multi-Level Listen). Für die Listenelemente werden der Einzug, die Ausrichtung und die Art der 
Nummerierung oder der Aufzählung festgelegt. Listenvorlagen werden in Absatzvorlagen integriert,
so dass die nicht von der Listenvorlage definierte Formatierung von der Absatzvorlage übernom-
men wird. Verwenden Sie eine Listenvorlage separat, so wird die bis dahin geltende Absatzvorlage
zu Grunde gelegt.

Der Vorteil der Verwendung von Listenvorlage ist, wie bei allen anderen Vorlagen auch, die Ein-
heitlichkeit und Konsistenz des Dokuments hinsichtlich der Formatierung sowie die schnellen Än-
derungsmöglichkeiten über das gesamte Dokument hinweg.

Obwohl sich einfache Listen durch die Verwendung der in der Symbolleiste Aufzählung und Num-
merierung befindlichen Symbole Nummerierung ein/aus und Aufzählungszeichen ein/aus er-

Listenvorlagen 50



stellen lassen, ist das Ergebnis oftmals nicht so wie erwartet. Das gilt insbesondere, wenn komple-
xe Listen mit mehreren Ebenen oder verschiedene Formatierungen in einer Liste gefordert oder 
gewünscht sind. Hinzu kommt, dass eine nachträgliche Änderung der Formatierung der manuell 
erstellten Listen sehr aufwändig und zeitraubend ist und für jede einzelne Liste separat durchge-
führt werden muss.

Notiz

In LibreOffice werden die Begriffe 'Nummerierte Liste' und 'Listenvorlage' oftmals 
etwas inkonsistent verwendet, aber sie stellen dasselbe dar. So werden z. B. im 
Formatvorlagenfenster (Sondertaste F11) in der Quickinfo zum Symbol Listenvor-
lagen 'Listenvorlagen' angezeigt.

Verschachtelte Listen
Eine verschachtelte Liste ist eine nummerierte oder mit Aufzählungszeichen versehene Liste, de-
ren Elemente ebenfalls Listen enthalten, die wiederum mit Nummern oder Aufzählungszeichen ver-
sehen sein können. Statt einer rein durchnummerierten Liste mit den Einträgen 1, 2, 3 .. werden 
häufig unterhalb dieser Einträge eingebettete und eingezogene Listen mit Nummerierungen wie a, 
b, c .. oder i, ii, iii .. o. ä. verwendet. Mit Hilfe der Listenvorlagen lassen sich alle möglichen Kombi-
nationen von Nummerierungen erstellen. Verschachtelte Listen können sogar Nummerierungs- 
und Aufzählungszeichen mischen.

Es gibt prinzipiell keinen Unterschied zwischen der Erstellung einer Listenvorlage für einfache und 
verschachtelte Listen; letztere erfordern ein wenig mehr Arbeit. In Kapitel 3 ''Arbeiten mit Text'' wird
ein Beispiel einer verschachtelten Liste gezeigt. In jenem Beispiel wurde die Liste aus einer vorde-
finierten Gliederungsvorlage erstellt, während in diesem Abschnitt ein allgemeinerer Ansatz zum 
Tragen kommt, der weitergehenden Anforderungen besser entspricht.

Neue Listenvorlagen erstellen
Das Dialogfenster für die Listenvorlagen besteht aus sieben Eigenschaftsseiten. Die Seite Verwal-
ten wurde bereits im gleichnamigen Abschnitt auf S. 6 beschrieben.

Aufzählungszeichen
Die Seite Aufzählungszeichen enthält acht vordefinierte, formatierte Listen (Abbildung 43). Um 
eine dieser Vorlagen zu nutzen, klicken Sie auf das Vorschaubild, das dann mit einer breiteren Um-
randung hervorgehoben wird. Ein Quickinfo weist auf die Aufzählungszeichen vor den Listenele-
menten hin. Diese Aufzählungszeichen sind Zeichen aus einem Zeichensatz.

Abbildung 43: Das Dialogfenster Listenvorlage, Seite Aufzählungszeichen.
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Nummerierungsart
Die Seite Nummerierungsart enthält acht vordefinierte, formatierte Listen (Abbildung 44). Um 
eine dieser Vorlagen zu nutzen, klicken Sie auf das Vorschaubild, das dann mit einer breiteren Um-
randung hervorgehoben wird. Ein Quickinfo weist auf die Nummerierungszeichen vor den Listen-
elementen hin. Die Nummerierungszeichen sind Ziffern.

Abbildung 44: Das Dialogfenster Listenvorlage, Seite Nummerierungsart.

Gliederung
Die Seite Gliederung enthält acht vordefinierte, formatierte Listen (Abbildung 45). Um eine dieser 
Vorlagen zu nutzen, klicken Sie auf das Vorschaubild, das dann mit einer breiteren Umrandung 
hervorgehoben wird. Ein Quickinfo weist auf die Gliederungszeichen vor den Listenelementen hin. 
Diese Gliederungszeichen können Zeichen aus einem Zeichensatz, aber auch Bilder oder Grafiken
sein, die auf der Seite Optionen (s. S. 56) angepasst werden können.

Abbildung 45: Das Dialogfenster Listenvorlage, Seite Gliederung.

Bild
Die Seite Bild enthält acht vordefinierte, formatierte Listen (Abbildung 46).
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Abbildung 46: Das Dialogfenster Listenvorlage, Seite Bild.

Um eine dieser Vorlagen zu nutzen, klicken Sie auf das Vorschaubild, das dann mit einer breiteren 
Umrandung hervorgehoben wird. Ein Quickinfo weist auf die Grafik vor den Listenelementen hin. 
Die Aufzählungszeichen sind Bilder oder Grafiken, die auf der Seite Optionen (s. S. 56) auch an-
gepasst werden können.

Position
Die Seite Position erlaubt die genaue Einstellung der Abstände, Einzüge und Ausrichtung sowohl 
für die Symbole als auch für den Text der Listenelemente (Abbildung 47). Zusammen mit der Seite 
Optionen können Sie die Listenvorlage genau nach Ihren Vorstellungen erstellen.

Abbildung 47: Das Dialogfenster Listenvorlage, Seite Position.

Die Seite ist in mehrere Bereiche unterteilt. Im mittleren unteren Bereich befindet sich ein Vor-
schaufenster, das Änderungen an den Einstellungen sichtbar macht.

Der Bereich Ebene zeigt alle zehn Ebenen an, die einzeln bearbeitet werden können. Der letzte 
Eintrag 1 – 10 erlaubt die gleichzeitige Einstellung aller Ebenen. Wählen Sie zuerst die zu bearbei-
tenden Ebenen aus.

Im Allgemeinen ist es günstiger, die Einstellungen nicht in der im Bereich Position und Abstand 
dargestellten Reihenfolge vorzunehmen, sondern in der nachfolgend beschriebenen Abfolge:
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• Nummerierung wird gefolgt von (Standard: Tabulator): Abstandselement, das der Num-
merierung folgt und den Abstand zwischen dem Nummerierungs-/Aufzählungszeichen und 
dem Listentext herstellt: Ein Tabulator, ein Leerzeichen, oder nichts. Nur bei der Auswahl 
Tabulator ist das nachfolgende Feld bei verfügbar.

• bei (Standard: abhängig von der Ebene): Nur wenn ein Tabulator auf die Nummerierung 
folgt: Tabulator-Position. Ist der Abstand zum Nummerierungs-/Aufzählungszeichen zu 
klein, so verschiebt das Zeichen den Text der ersten Zeile.

• Einzug bei (Standard: abhängig von der Ebene): Abstand vom linken Seitenrand bis zum 
Beginn des Listentextes, der nach einem Zeilenumbruch der ersten Zeile folgt.

• Ausgerichtet bei (Standard: abhängig von der Ebene): Abstand vom linken Seitenrand 
zum Nummerierungssymbol.

• Ausrichtung der Nummerierung (Standard: Links): Die Ausrichtung des Nummerierungs-
symbols einschließliches des davor stehenden Textes:

◦ Links (Standard): Das Nummerierungssymbol beginnt an der durch das Feld Ausge-
richtet bei festgelegten Position.

◦ Rechts: Das Nummerierungssymbol endet vor der durch das Feld Ausgerichtet bei 
festgelegten Position.

◦ Zentriert: Das Nummerierungssymbol wird zentriert um das durch das Feld Ausge-
richtet bei festgelegten Position angeordnet.

• Standard: Die Einrückungen und Abstände werden über die Schaltfläche auf ihre Stan-
dardwerte zurückgesetzt.

Achtung Die Option Ausrichtung der Nummerierung richtet das Nummerierungs-/Aufzäh-
lungszeichen aus, wenn die Nummer größer werden und damit mehr Platz einneh-
men, z. B. größer als 10. Die Option dient nicht der Absatzformatierung.

Tipp
Normalerweise werden die Einträge Nummerierung wird gefolgt von und Ein-
zug bei gleich gesetzt. Abbildung 48 zeigt die Auswirkungen der beiden Einstel-
lungen.

1. Das ist der erste Eintrag der ersten Ebene 
einer numerischen Liste: Bei: 0,5 cm; 
Einzug bei: 0,5 cm

2. Das ist der zweite Eintrag der ersten Ebene 
einer numerischen Liste: Bei: 0,5 cm; 
Einzug bei: 0,5 cm
1. Das ist der erste Eintrag der zweiten 

Ebene einer numerischen Liste: Bei: 1,0 
cm; Einzug bei: 1,0 cm

1. Das ist der erste Eintrag der ersten Ebene 
einer numerischen Liste: Bei: 0,5 cm; 
Einzug bei: 1,0 cm

2. Das ist der zweite Eintrag der ersten Ebene 
einer numerischen Liste: Bei: 0,5 cm; 
Einzug bei: 1,0 cm

1. Das ist der erste Eintrag der zweiten 
Ebene einer numerischen Liste: 
Bei: 1,0 cm; Einzug bei: 2,0 cm

Abbildung 48: Beispiel für unterschiedliche Werte in den Feldern Bei und Einzug bei.

Abbildung 49 zeigt noch einmal die wesentlichen Größen zur Einstellung der Abstände in einer Lis-
tenvorlage:
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Abbildung 49: Listenvorlage mit verschiedenen Einstellungen für die Felder: 
a) Bei; b) Ausgerichtet bei; c) Einzug bei.

Achtung

Die Seite Position unterscheidet sich im Aussehen bei Dokumenten, die die Posi-
tions- und Leerzeichenattribute benutzen, die mit OpenOffice.org 3.0 eingeführt 
wurden (und in allen Versionen von LibreOffice benutzt werden), und Dokumenten,
die die alten Attribute der Versionen vor 3.0 benutzen. Die neue Version dieser Re-
gisterseite zeigt die Steuerelemente "Nummerierung wird gefolgt von", "Ausrich-
tung der Nummerierung", "Ausgerichtet bei" und "Einzug bei". Die alte Version die-
ser Registerseite, die in einer alten nummerierten oder mit Aufzählungszeichen 
versehenen Liste zu sehen ist, zeigt die Steuerelemente "Einrückung", "Breite der 
Nummerierung", "Mindestabstand Nummer <-> Text" und "Ausrichtung der Num-
merierung". Ausführungen zur Bedeutung der Felder nach der alten Version finden
Sie im nachfolgenden Abschnitt und in der Hilfe auf der Seite Position.

Position für Dokumente, die mit dem ODF-Format 1.1 oder früher erstellt wurden
Wenn Ihr Dokument mit ODF-Version 1.1 oder früher erstellt wurde, z. B. in einer älteren Version 
von OpenOffice.org, und mit LibreOffice geöffnet wird, ist die Darstellung der Seite Position an-
ders als im Abschnitt Position auf Seite 53 beschrieben. Abbildung 50 zeigt die Seiten für die ODF-
Version 1.1.

Abbildung 50: Das Dialogfenster Listenvorlage, Seite Position.

Der grundlegende Aufbau mit der Auswahl der Ebenen und dem Vorschaufenster ist gleich. Die un-
terschiedlichen Einstellmöglichkeiten werden hier beschrieben:

• Einzug (Standard: 0,0 cm): Abstand zwischen dem linken Seitenrand (bzw. dem linken 
Rand des Textobjekts) und dem linken Rand des Nummerierungs-/Aufzählungszeichens 
sein soll. Wenn in der aktuellen Absatzvorlage bereits ein Einzug definiert ist, wird der hier 
eingegebene Abstand zu diesem Absatzeinzug aufaddiert.

• Relativ (Nur für Ebenen größer 1): Der im Feld Einzug eingegebene Wert wird zum Einzug
der vorherigen Ebene addiert und gibt nicht den Abstand zum linken Rand an.
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• Breite der Nummerierung (Standard: 0,50 cm): Abstand zwischen dem linken Rand des 
Nummerierungs-/Aufzählungszeichens und dem linken Textrand. (Breite für Nummerie-
rungs-/Aufzählungszeichen). Die angegebene Breite wird von Writer immer reserviert.

• Mindestabstand Nummer <-> Text (Standard: 0,00 cm): Mindestabstand zwischen rech-
ten Rand des Nummerierungs-/Aufzählungszeichens und erster Zeile des Listentextes. Ist 
der Abstand zum Text nicht ausreichend, wird Writer die Breite für das Nummerierungs-/-
Aufzählungszeichen vergrößern. Die Angabe eines Mindestabstandes ist sinnvoll bei 
rechtsbündigem Text, der auf die Nummerierung von rechts zuläuft.

• Ausrichtung der Nummerierung (Standard: Links): Ausrichtung der Nummerierung ein-
schließlich des Textes vor und nach der Nummerierung.

• Standard: Die Einrückungen und Abstände werden über die Schaltfläche auf ihre Stan-
dardwerte zurückgesetzt.

Tipp

Um zu verstehen, wie die Ausrichtung und Positionierung von Nummerierungen 
funktioniert, erstellen Sie eine nummerierte Liste mit mehr als 10 Listeneinträgen. 
Stellen Sie die Abstände so ein, dass die breiteste Nummer mit zwei oder mehr 
Zeichen genug Platz haben. Es können auch mehr als zehn rechts ausgerichtete 
Nummerierungszeichen sein.

Optionen
Die Formatierungen für Nummerierungen und Aufzählungen werden auf der Seite Optionen 
durchgeführt. Sie können die einzelnen Ebenen separat formatieren. Der letzte Eintrag 1 – 10 er-
laubt die gleichzeitige Änderung aller Ebenen. Wählen Sie zuerst die zu bearbeitende Ebene aus. 
Wenn Sie auf den Seiten Aufzählungszeichen, Nummerierungsart oder Bild bereits eine Vor-
auswahl getroffen haben, so wird die Seite Optionen angepasst und mit den entsprechenden Wer-
ten vorbelegt. Rechts befindet sich ein Vorschaufenster, das die Auswirkungen der getätigten Ein-
gaben anzeigt.

Im Bereich Listen können Sie die Einstellungen vornehmen:

• Nummerierung (Standard: keiner, abhängig von Vorauswahl): Aus einer Auswahlliste se-
lektieren Sie die gewünschte Nummerierungsart für die Ebene (Tabelle 3).

Tabelle 3: Auswahl von Nummerierungsarten

Auswahl Kommentar
1, 2, 3, ... Arabische Ziffern

A, B, C, ... Großbuchstaben

a, b, c, ... Kleinbuchstaben

I, II, III, ... Große römische Ziffern

i, ii, iii, ... Kleine römische Ziffern

A, .. AA, .. 
AAA, ...

Alphabetische Nummerierung mit Großbuchstaben

a, .. aa, .. 
aaa, ...

Alphabetische Nummerierung mit Kleinbuchstaben

Bullet Fügt am Zeilenanfang ein Aufzählungszeichen ein. Wählen Sie diese Option 
aus, und klicken Sie auf die Schaltfläche Zeichen, um einen Stil für das Auf-
zählungszeichen auszusuchen.
Aufzählungszeichen werden an die aktuelle Zeilenhöhe angepasst. Sie haben
die Möglichkeit, den Aufzählungszeichen durch Auswahl einer Zeichenvorlage
eine andere Schriftgröße zu verleihen. 
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Auswahl Kommentar
Grafik Zeigt eine Grafik als Aufzählungszeichen an. Wählen Sie zunächst diese Opti-

on aus, und klicken Sie dann auf Auswahl, um die gewünschte Bilddatei aus-
zusuchen. Das Bild wird ins Dokument eingebettet.

Grafik ver-
knüpft

Zeigt ein Bild für das Aufzählungszeichen an. Wählen Sie diese Option und 
klicken Sie dann auf Auswahl, um das Bild zu wählen, das Sie benutzen 
möchten. Das Bild wird als eine Verknüpfung zur Bilddatei eingefügt.

Keine Es wird kein Nummerierungsstil angewendet.

Je nach Auswahl der Nummerierungsart sind nachfolgend weitere Felder verfügbar (Abbil-
dung 51). Die zugehörigen Felder bei der Auswahl Bullet, Grafik oder Grafik verknüpft 
werden weiter unten beschrieben.

Abbildung 51: Das Dialogfenster Listenvorlage, Seite Optionen und Aus-
wahl einer Nummerierungsart.

• Zeichenvorlage (Standard: Nummerierungszeichen): Zeichenvorlage für die Nummerie-
rungszeichen. Angezeigt werden die im Fenster Formatvorlagen verfügbaren Zeichenvorla-
gen. Sind Zeichenvorlagen neu zu erstellen oder anzulegen, ist das im Fenster Formatvor-
lagen durchzuführen.

• Vollständig (Standard: 1): Gibt an, wie viele Ebenen in der Nummerierung zu berücksichti-
gen sind.
Beispiel: Für die erste Ebene wurde die Nummerierungsart "A, B, C..." und für die zweite 
Ebene die Nummerierungsart "1, 2, 3, …" ausgewählt, so wird für Vollständig = ''2'' die 
zweite Ebene mit der Nummerierung ''A.1'', ''A.2'' usw. beginnen.

• Vor (Standard: Kein): Element (Zeichen, Zeichenfolge oder Text), das vor der Nummerie-
rung in der Liste angezeigt werden soll.
Beispiel: Für eine Nummerierungsliste mit dem Format "Pkt. 1", geben Sie in dieses Feld 
"Pkt. " ein. Vergessen Sie nicht ein Leerzeichen mit einzugeben, um ''Pkt.'' von dem Num-
merierungszeichen ''1'' zu trennen.
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• Hinter (Standard: ''.''): Element (Zeichen, Zeichenfolge oder Text), das nach der Nummerie-
rung in der Liste angezeigt werden soll. 
Beispiel: Für eine Nummerierungsliste mit dem Format "1.)", geben Sie in dieses Feld ".)" 
ein.

• Beginn bei (Standard: 1): Anfangsnummer für die aktuelle Ebene.
Beispiel: Eine Nummerierungsliste soll erst mit ''10'' beginnen, so geben Sie in dieses Feld 
"10" ein.

Nummerierung: Auswahl Grafik und Grafik verknüpft

• Auswahl: Auswahl einer Grafik als Datei oder als Aufzählungszeichen aus der mit LibreOf-
fice ausgelieferten Zeichen (Gallery).

Achtung
Wenn Sie die Nummerierungsart Grafik verknüpft wählen, wird im Dokument nur 
der Pfad und der Dateiname zu der Grafikdatei hinterlegt. Wird das Dokument auf 
einem anderen Rechner geöffnet, auf welchem die Datei nicht vorhanden ist oder 
der Pfad oder Dateiname falsch ist, so werden die Grafiken im Dokument nicht an-
gezeigt.

• Breite (Standard: 0,0 cm): Breite der Grafik.

• Höhe (Standard: 0,0 cm): Höhe der Grafik.

• Seitenverhältnis beibehalten (Standard: Nicht aktiviert): Das Verhältnis Höhe/Breite bleibt
bei der Skalierung erhalten.

• Ausrichtung (Standard: Basis oben): Ausrichtung der Grafik.

Nummerierung: Auswahl Bullet

• Zeichenvorlage (Standard: Nummerierungszeichen): Zeichenvorlage für die Nummerie-
rungszeichen. Angezeigt werden die im Fenster Formatvorlagen verfügbaren Zeichenvorla-
gen. Sind Zeichenvorlagen neu zu erstellen oder anzulegen, ist das im Fenster Formatvor-
lagen durchzuführen.

• Zeichen: Die Schaltfläche öffnet das Dialogfenster Sonderzeichen zur Auswahl eines Auf-
zählungszeichen.

Im Bereich Alle Ebenen Legen Sie die Nummerierungsoptionen für alle Ebenen fest:

• Fortlaufende Nummerierung (Standard: Nicht aktiviert): Alle Ebenen werden fortlaufend 
nummeriert.

Listenvorlage in Absatzvorlage verwenden
Dir Verwendung von Listenvorlagen ändert nicht die zugrunde liegende Absatzvorlage. Eine Liste 
wird auch durch solche Eigenschaft wie Schriftart, Schriftgröße, Zeilenabstand u. a. gekennzeich-
net. Daher könnte man erwarten, dass zuerst die Absatzvorlage und dann die Listenvorlage auszu-
wählen/anzuwenden ist (oder umgekehrt). Aber es geht einfacher: Die Listenvorlage wird über die 
Seite Gliederung & Nummerierung der Absatzvorlage eingebunden. Anschließend braucht nur 
noch mit der Absatzvorlage gearbeitet werden, d. h. die Absatzvorlage dem Text zugeordnet wer-
den.

Dieser Abschnitt zeigt ein Beispiel für die Verwendung von Listen- in Absatzvorlagen:

1) Erstellen Sie eine Listenvorlage, die Sie verwenden möchten, z. B. Meine Listenvorlage.

2) Erstellen Sie eine neue Absatzvorlage.

3) Auf der Seite Verwalten der Absatzvorlage:

a) Vergeben Sie im Feld Name eine aussagekräftige Bezeichnung für die Absatzvorlage, 
z. B. Nummerierter Absatz.
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b) Im Feld Folgevorlage wird automatisch der neue Name eingetragen. Den lassen Sie 
unverändert.

c) Im Feld Verknüpft mit wählen Sie den Eintrag -Keine-.

d) Das Feld Bereich lassen Sie auf Benutzervorlagen.

4) Richten Sie den Absatz nach Ihren Wünschen ein. Da die Einzüge durch die Listenvorlage 
kontrolliert werden, ändern Sie die Einstellungen dazu auf der Seite Einzüge und Abstän-
de nicht. Die Abstände die über und unter dem Absatz (Felder: Über Absatz und Unter 
Absatz) können Sie jedoch ändern.

5) Auf der Seite Gliederung & Nummerierung wählen Sie im Feld Listenvorlage die eben 
erstellte Listenvorlage Meine Listenvorlage aus.

6) Mit OK sichern Sie die Vorlage und verlassen das Dialogfenster.

Es ist allgemein Praxis und ein guter Stil, für eine Liste mehrere Absatzvorlagen zu definieren, 
davon drei Absatzvorlagen für die nummerierte Liste:

• Liste Einführung: Absatzvorlage für den einführenden Text zur Liste, der vor dem ersten 
Listeneintrag steht und noch nicht eingezogen ist. Der Abstand zum ersten Listeneintrag ist
etwas verkürzt, um die Zugehörigkeit des Textes zu betonen.

• Liste Start: Die Absatzvorlage für das erste Listenelement. Der Abstand zum nächsten Lis-
teneintrag ist etwas verkürzt.

• Liste Inhalt: Die Absatzvorlage für alle folgenden, aber ohne das letzte Listenelement. Der 
Abstand zum nächsten Listeneintrag ist etwas verkürzt.

• Liste Ende: Die Absatzvorlage für das letzte Listenelement. Der Abstand zum nachfolgen-
den Text sollte zur Abgrenzung etwas größer sein.

• Liste Ohne: Absatzvorlage für einen nicht nummerierten Absatz, d. h. ein Absatz ohne 
Nummerierungszeichen, um längere Texte auch mit Einzug unterhalb des Listeneintrags zu
schreiben. Diese Absatzvorlage sollte für jede Listenebene erstellt werden.

Beispiel: Erstellen einer einfachen Liste
In diesem Beispiel wird eine nummerierte Liste erstellt, die die Lieder auf einer CD auflisten soll. 
Die Nummerierung soll rechts ausgerichtet sein und zwischen dem Nummerierungszeichen und 
dem Listentext soll ein Abstand eingehalten werden. Da die Liste auch für andere CD's verwendet 
werden soll, wird eine Listenvorlage erstellt.

Nummerierte Liste für die CD-Tracks
Öffnen Sie das Formatvorlagenfenster (über die Funktionstaste F11, das Menü Format > Format-
vorlagen oder das Symbol  oder  in der Symbolleiste Format zu erreichen) und das Symbol  
um die Listenvorlagen anzuzeigen. Mit einem Rechtsklick auf eine vorhandene Listenvorlage oder 
in den leeren Bereich des Fensters öffnet sich ein Kontextmenü: Der Menüpunkt Neu öffnet ein 
Dialogfenster zur Bearbeitung der Listenvorlage. Für die Listenvorlage sind Eintragungen auf den 
Seiten Verwalten, Position und Optionen vorzunehmen.

Auf der Seite Verwalten sind nachfolgende Felder anzupassen:

• Name: CD-Track

• Bereich: Benutzervorlagen.

Auf der Seite Position machen Sie dazu nachstehende Angaben:

• Ebene: 1

• Nummerierung wird gefolgt von: Tabulator

• bei: 4,0 cm
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• Einzug bei: 4,0 cm (Abstand vom linken Seitenrand bis zum Beginn des Listentextes, der 
nach einem Zeilenumbruch der ersten Zeile folgt)

• Ausgerichtet bei: 1,5 cm (Abstand linker Seitenrand zum Nummerierungszeichen)

• Ausrichtung der Nummerierung: Rechts.

Ändern Sie die Seite Optionen wie folgt:

• Ebene: 1

• Nummerierung: 1, 2, 3, …

• Zeichenvorlage: keine

• Vollständig: 1

• Vor: Kein Eintrag

• Hinter: ''.''

• Beginn bei: 1.

• Fortlaufende Nummerierung: Nicht aktiviert.

Wie oben bereits dargestellt, übernimmt die Liste die zugrunde liegende Absatzvorlage. Falls für 
die Nummerierung ein spezieller Zeichensatz, eine andere Schriftgröße oder -farbe erforderlich ist,
so erstellen Sie einen entsprechenden Zeichensatz und binden diesen auf der Seite Optionen un-
ter Zeichenvorlage ein.

Um das Wort Track vor die Nummerierung zu stellen, tragen Sie es in das Feld Vor ein. Achten 
Sie darauf, dass nach dem Wort auch das Leerzeichen mit eingegeben wird, sonst erscheint die 
Nummerierung direkt am Wort, so z. B. ''Track1''.

Nach Abschluss aller Einstellungen speichern Sie die Änderungen mit OK.

Mit der neuen Listenvorlage CD-Track arbeiten
Jetzt können Sie mit der neuen Listenvorlage arbeiten, die jetzt im gesamten Dokument als Vorla-
ge verfügbar ist:

1) Möchten Sie die Listenvorlage nutzen, erzeugen Sie mit RETURN einen neuen Absatz 
(neue Zeile).

2) Doppelklicken Sie im Formatvorlagenfenster bei den Listenvorlagen auf Ihren neue Listen-
vorlage CD-Track.

Wenn Sie bereits eine Liste haben, die Sie nach dem Vorbild von CD-Track formatieren wollen, 
markieren Sie die Liste und doppelklicken Sie anschließend auf Ihre Listenvorlage CD-Track.

Notiz
Beachten Sie, dass die Listenvorlage nicht die zugrunde liegende Absatzvorlage 
beeinflusst. Deshalb sollten Sie vorher die Absatzvorlage prüfen, ob diese Ihren 
Ansprüchen genügt.

Wenn Sie mehr als zwei Listen in Ihrem Dokument erstellen, wird die zweite Liste die Nummerie-
rung der ersten Liste fortführen. Um auch bei der ersten Liste mit 1 zu starten, platzieren Sie den 
Cursor irgendwo in die Liste und wählen nach einem Rechtsklick aus dem Kontextmenü Numme-
rierung neu beginnen.

Um die Nummerierung ein- oder auszuschalten, klicken Sie auf das Symbol Nummerierung 
ein/aus oder verwenden die Sondertaste F12; um die Nummerierung nur auszuschalten verwen-
den Sie die Tastenkombination Strg+Umschalt+F12.
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